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Translations

This topic provides a beginner-level overview of STEP's translation capabilities and assumes that the user has a
working knowledge of the STEP system. In this topic we will discuss the kinds of objects that are suitable for
translation, the various ways STEP enables users to translate content, and a primer on the various terms and
statuses users are likely to find while exporting content for translation. Detailed guidance covering other aspects of
the translation process, like executing XML and Excel exports, importing files, and handling errors, can be found in
their own topics.

STEP enables translation of a wide range of data. Using language-driven contexts, multiple translations can be
created for a single STEP object. This allows an object to be translated into multiple languages while the core
object retains all translated data and inter-language connections.

Briefly, STEP translation works like this: when a user exports, for example, a product hierarchy for translation, all
language-dependent attribute values for those products are extracted for translation. The content is then
translated, often by a translation vendor, and imported into STEP. All translated values flow into the appropriate
attribute in the relevant language context. The second time that same product hierarchy is extracted for
translation, the attribute values are evaluated as part of an automated process, and only those values that are new
or have amended content are extracted for translation.

It is important to note that STEP enables data to be translated but does not translate data itself. Throughout the
guidance on this subject you may see reference made to 'starting translation' in STEP. This statement refers to the
act of exporting the to-be-translated content from STEP so it may be sent elsewhere for translation.

Translatable Objects
The object types in STEP that may be translated are:

» Products

« Classifications

« Asset names (names of images and documents, for example)
« Product values

« Indexwords

o LOV (List Of Values)

o Units

« Attribute names

« Freetextcellsin tables

Translation Methods
The following methods are available in STEP to extract data for translation:
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« Structured translation: Translatable data is exported from STEP into either an XML or Excel file. The file can
then be imported into the translation vendor's translation memory tool. Once the data has been translated and
sent back from the translation vendor, the updated file can be imported back into STEP, bringing all translated
data into its relevant context. It is useful to note that translation XML files can only be produced using the
structured translation method.

- Manual Excel translation export: A more targeted export of translatable data into an Excel file. This method
is often used to quickly send small amounts of data to a translation vendor to address a late change to already-
exported data. Once the data has been translated and sent back from the translation vendor, the Excel file can
be imported back into STEP, bringing the translated data into its relevant context. All objects can be translated
using this method, except free text cells in tables and reference / link metadata.

« Manual translation: Data is translated directly in STEP, either by allowing a third-party translation vendor
direct access to STEP or by allowing an internal resource fluent in the target language to translate directly in
STEP.

« Asynchronous translation: For customers who engage translation vendors SDL or Lionbridge or use the
Across Language Server translation software to translate their content, a REST API can be set up that will
enable automatic transmission of translated content (in XML format) between STEP and the translation
servers. Another asynchronous option, the File Exchange Service, allows users a way to export and/or import
translation files to folders instead of using a translation service API.

Not all object types can be exported for translation into an XML and Excel file. The table below shows which
translation methods are available for which objects.

Structured Translation Manual Excel [\ ELIE] Asynchronous
Translatable Translation Translation Translation
Object XML _ Excel _
Translation Translation
Product, v v v v v
classification,
asset names,
and values
Index words v v v v v
Free text v X X v v
cellsin tables
LOVs o * X v W o
Units X X v v ) 4
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Structured Translation Manual Excel Manual Asynchronous
Translatable Translation Translation Translation
Object XML _ Excel _

Translation Translation
Attribute v x o v X
names
Reference/ | + X X v v
link metadata

*Exception: not available for LOV's configured a) to disallow new values or b) without value IDs assigned to the
LOV's values.

Translation Relations

In most instances, the objects being translated are subject to revision control, which requires that the data be
approved before it can be exported for translation. This requirement is in place to ensure that different revisions of
an object in translation remain clearly defined. Once the translation is complete, a translation relation is
established from the source language to the target language.

Note: Users have the option to turn the approval requirement off in the 'Object Selection' screen in the Request
Translation wizard. By leaving the 'Completely Approved Source' option unchecked on the 'Approval
Requirement' parameter, an object need not be completely approved to be exported for translation, though only
content from the Approved workspace will be included in a translation export. If, however, an object has never
been approved, that object will not be exported even if the 'Completely Approved Source' box is unchecked.

A translation relation refers to the relationship between an object's source language and the language the object is
being translated into, also known as the target language. For instance, if you translate an object in US English into
French, German, and Italian, you have created three translation relations: US English to French, US English to
German, and US English to Italian.

Translation of Local and Inherited Values

All values that are unique to a given object — also known as 'local' values — are extracted for translation. Local
values are non-inherited values; they are added directly to a given object.

Inherited values are values that are inherited from other objects at a higher level. They can be identified by a green
inverted triangle symbol (=) that appears in the icon column. If an inherited value has already been translated at a

higher level, it will not be extracted for translation. When an inherited value is overwritten or revised in any way on
a given object, it becomes a local value to that object. If that higher-level value is then edited, that edit will not affect
the now-local value as it is no longer inherited from that higher-level value.

For more information on inheritance, see the Inheritance in the Product Hierarchy topic in the Getting
Started / User Guide.
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Translation terms
When managing translations, it's important to understand these terms that reference the various languages
involved in the translation process:

« Master language: The first language used as source language

« Source language: The language from which a translation originates

. Target language: The language being translated into

A source language may be translated into as many target languages as have been set-up on a given STEP
system. In the screenshot below, you can see the Status tab on an object. The user has selected English as the
master language for this object. The user has also elected to translate the object into five target languages: UK
English, German, Hebrew, French, and Danish.

12-GGK79 rev.0.64 - Status

Product || Sub Products || References || Referenced By | Images & Documents || Proof View @ State Log | Tasks

e w'urkspaces

"? Translation

Master : Engllsh o _

[ Teouwea > Target - > Status |
» English ..UK Enalish RE-TransJatDn Meeded ..
» Engllsh w_German In F‘rugress
> Engllsh ._Hebrew _F'.E Translahu::n Meeded
» _Engllsh ”French Re-Translation Meeded
?....English Da"ld'! In Progress

Translation Status

On each classification, product, or asset you can view an object's translation status, which is the value appearing in
the Status column in the above screenshot. There are two ways to view the translation status of an object:

« Inthe Tree, select the relevant object, and then click the Status tab. The view will resemble the screenshot
above.

« Inthe Search tab, search for the translation status of specific object types. For more on searching for
translation status, see the Searching for Translation Status topic.

In the collapsible Translation section of the Status tab content, the third column is 'Status.' For each Translation
Relation listed in this section, a status is displayed. One of the three statuses listed below will appear:
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Status Description

Re- Translated content in the source language has changed since the most recent translation
Translation | completed. This status indicates a re-translation from the source into the target language is
Needed needed to bring all content up to date.

Upto Date | Notranslated contentin the source language has been changed since the previous translation.
Translation from source language into target language is up to date.

In A translation extraction has been done and is currently running as an active background process.
Progress Once the translated content has come back from the translation vendor and the file has been
imported, the background process will complete and the status will update to Up to Date.

Note: System data such as attributes, LOV's and units are not under revision control. Therefore, STEP does not
create a translation relation or a translation status for each language the objects have been translated into. To
learn more about translating these kinds of object types, see the Structured Translation for Setup Objects
documentation.

Additional settings can be applied to all STEP translations by accessing the 'Users & Groups' node on the 'System
Setup' tab in the workbench. This is where users can configure how translation files are named, whether the 'Filter
spreadsheet' parameter should display in the 'Request Translation' wizard, and, if so, what the default value
should be. For more information on these settings, see the Translation Settings section of the System Setup /
Super User Guide documentation.
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Preparing Data for Translation

This topic describes how to configure data so that when a user exports content for translation, that data is included
in the translation export file. Users who read and understand this topic should be able to make objects language
dependent, which will in turn make them suitable to be exported for translation. For a more general overview of the
STEP translation functionality, see the Translations topic within this guide.

To translate contentin STEP, the various data values that comprise that content must be defined as "translatable".
For example, a customer name may not be useful to translate as it is the same no matter what language or country
it appears in. However, a product's short description would be useful to translate as that description text,
translated into the native language of the target market, would make it more effective.

To define an attribute or other object as translatable, that object must be designated as language dependent.
Typically, this is done as part of the initial data model when content is first brought into STEP, but it can also be
done after an object has already been added.

Listed below are the various methods used to make objects language dependent.

Specifying language dependency

Before objects in a hierarchy may be extracted for translation, the user must specify which attributes, object types,
and table types associated with that object will be language dependent.

Specifying language dependency at attribute creation

The most standard way to assign language dependency to an attribute is through the Create Attribute wizard
when attributes are first being defined.

Step six in the Create Attribute wizard is called Apply Dimension Dependencies (screenshot below).
Checking the Language checkbox designates the attribute being created as translatable. When this attribute is
part of a translation export and its status is either Never Been Translated or Requires Re-Translation, this
attribute's value will be included in the export file for translation.

To read more about the attribute creation process, review the Creating Attributes topic in the System Setup /
Super User Guide documentation.
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E] Create Attribute

[t

Steps

1, Select Atiribute Group
2. Enter ID and MName

3. Enter Validation Rule
4, select Unit(s)

5. Valid For

6. Apply Dimension Dependencies

7. Link to Hierarchy

Apply Dimension Dependencies

[] Country

[ Back H Mext H Einish H Cancel

Specifying language dependency on existing attributes

A language dependency can also be applied to any existing attribute by going directly into the attribute via the
System Setup tab.

1.
2.

In System Setup, expand Attribute Groups, and then select the relevant attribute.

On the Attribute tab, in the Dimension Dependencies field, first double click inside the Value cell, and then

click the ellipsis button ([...)).

In the Select Dimension Dependencies dialog (pictured below), click the box beside Language, and then

click Apply.

System Setup

=127 Attribute Groups
--I‘:'_‘:“l Attribute Group

B3 Computers

[#--E21 Mew_Attribute_Group
----- [T air gauge induded

----- [IT Alowable Ampacities
----- [IT Batteries nduded

----- DI Battery Type

----- [IT Brightness

----- [T circular Area (cmils)
----- [IT conductor Gauge

..... DI Co-op

----- [T csa Lsted

----- [IT oc Resistance (ohms)

----- [IT piameter {n'uls}
MF Mimr Pimemmminme

Cable/Wire Type - Attnbutp

m References || Attribute Transformation || Validity || Profile State Log || Tasks

=51 Category Specific Attributes

D Description
Mame Value »
» ID CableWireType
» Mame Cable\Wire Type
» Last edited by 2015-11-05 15:18:34 by LATO

v

Full Text Indexable

W

Externally Maintain

Select Dimension Dependencies

W

Hierarchical Filtering

W

Calculated

Type

v

Dimension Depende

W

Mandatory

Cryptographic Key

W

Attribute Help Text

[ Eountry

Language

Level of difficulty of applying changes: 0

Operation might be time consuming

Cancel
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Checking Language will designate the attribute as translatable. This means that when a translation export is
initiated that includes this attribute, this attribute's value will be included in the export file. For more information on
editing attributes, see the Editing Attribute Values documentation.

Specifying language dependency on System Setup objects

A language dependency can also be applied to objects at the level of the object type. Applying the language
dependency means that all objects of the object type you configure will make the name of that object type
language dependent. Using the sales item object type as an example, if we apply language dependency to the
sales item object type, then all sales items names can be exported for translation. It does not mean that all sales
item values now have a language dependency.

To apply language dependency to an object type, users should follow these steps:

System Setup

Jales Item - Object Type

l ] Alternate Classifications Elb]ec:t 10 M | References
‘ Assets
5 & Description ~
[+ Basic Object Types " o> Nal .
[+-§5 Commerdial Types me EuE
%’ Entity user-type root » D SalesTtem
[;E‘ Event Queue Object Types > Mame Sales Ttem
E--?;m;fy P“;d”ddcgasjﬁzh"” > Last edited by 2016-10-05 10:59:52 by USER]
- iscontinued Produ
{%’ External Products * Mame Pattern
- ackaging Hierarchy » attern i
-l Packaging Hierarch ID Patte [ic]
r_=| Primary Product Classification > Manually Sorted Ves
B[] Product Overrides :
Elij Products » Enable Profiling fes
E}|“_=| Levell * InDesign Template Allowed Mo
E|r_=| Level2 » [con l_
g Level3
= E“?ite { Dimension Dependendies | IZ‘
- m
i » Reference Target Lock Policy i
-l 1tem Folder Refe Target Lock Pol Strict
1“_=| Level4 »
|-:~|r_=| Sales [tem Folder S 32 Select Dimension Dependencies
[+ SalesItemFamily >0 [ 1Couniry
-G Product-Overrides > [
-2 Publication group types > B
-z Publication section types ', g Level of difficulty of applying changes: 0
[+}-[27' Publication types |
[3--% Setup Group root » { Operation might be time consuming
o) Taos TE
Units —i Cancel
> H
A | lemre & fronine

1. In System Setup, expand the Object Types & Structures node, and then select the relevant object type.

2. Onthe Object Type tab, in the Dimension Dependencies field, first double click in the Value cell, and then
click the ellipsis button ([...).

3. Inthe Select Dimension Dependencies dialog that displays, click the box beside Language, and then click
Apply.
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Specifying language dependency on table types

STEP also enables language dependency to be set by table type. This enables any free text elementsina
language-dependent table to be included in a translation export.

To apply a language dependency to a table type, follow these steps:

1. In System Setup, expand Table, and then select the relevant table type. In this example, the table type is
Pivot Table.

System Setup < Pivot Table - Table Type i
cﬁa Users & Groups -

B’h Reference Types

MName >| » |Value Jl =
* MName Pivot Table
» Edited by 2016-08-09 16:15:03 by USERA =
» Defaults Fule Above:0.5 pt Rule Below:0. 5 pt Rule Left:0. 5 pt Rule Right:0.5 pt
» Dimension Dependencies
* Pagination Plugin Mone
----- [l compact Parthio @ Legal Row Types
..... il compact Price Default » IName >
----- filfl Compact Spedfication Right > @ Column Header Row
""" fif] oummy > | Compact Bottom Row 1
----- m LH Compact Spedfications .
_____ m RH Compact Specifcations L )] Compact Header Row 1
----- m RedBold > D Compact Header Row 2

2. Onthe Table Type tab, in the Dimension Dependencies field, click the ellipsis button (...)).

System Setup Pivot Table - Table Type

(-7 Users & Groups Bl Table Type
I:I--E.h Reference Types i
5%+ Workspaces Marme »| » |Value L
[—]--@ Table » Name Pivot Table
? Colors » Edited by 2016-03-09 16:15:03 by USERA =
- Rules
[_}_% Table Types > Defaults Rule Above:0.5 pt Rule Below:0.5 pt Rule Left:0.5 pt Rule Right:0.5 pt
EI% Fivat Tables » Dimension Dependencies E] -
=] Pivet Table > Pagination Plugin None
----- ] Bold
----- {ff] compact Partio § Legal Row Types
..... fif| Compact Frice Default * [Name >
----- [ffl Compact Spedfication Right > @ Column Header Row
----- [l Durnmy
* 0 Compact Bottom Row 1
----- fffl LH Compact Spedifications .
_____ il RH Compact Specifiations > B Compact Header Row 1
..... ] redBold ) Compact Header Row 2

3. Inthe Select Dimension Dependencies dialog, select Language, and then click Apply.
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l.. Reference Types

 Workspaces
E@ Table

}'& Colors
.(gg Rules

[—}-% Table Types
EI--% Pivot Tables

- PivetTable]

m Compact Partho
m Compact Price
m Compact Spedfication Right

[ LH Compact Specifications
[ffi rRH Compact Spedifiations
[l RedBold

[l spec Column

{ffl spedfication

[ Column Headsr Row

|m Compact Bottom Row 1
[ compact Header Row 1
[ compact Header Row 2
[T Mormal Row
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Pivot Table - Table Type

Table Type

Mame »[ > |value >
> Mame Pivot Table
> Edited by 2016-08-09 16:15:03 by USERA
» Defaults Rule Above:0.5 pt Rule Below:0.5 pt Rule Left:0.5 pt Rule Right:0.5 pt
» Dimension Dependencdies |B
* Pagination Flugin Mone

>
> |
> |
> |
L Level of difficulty of applying changes: 0
L Operation might be time consuming
>
i | Aesly || cancel |
>
s @ Rl
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Structured Translation

Translating content using the structured method is how most STEP users translate large amounts of data. By
selecting objects and initiating the Request Translation Wizard, STEP walks the user through creation of a
translation export XML or Excel file. This section of the translation guide covers:

o Structured XML Translation
o Structured Excel Translation
« Starting a Structured Translation

« Structured Translation of Setup Objects
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Structured XML Translation

In this topic, the basics of exporting translation data into an XML file via the structured translation method will be
covered at a high level, with more detail about the various aspects of STEP translation appearing in other sub-
topics.

Of the available translation options, exporting translatable data to XML using the structured translation format
works best for handling large amounts of content, and is well-suited for enabling automated translation solutions.

When an XML translation export is initiated, an XML file is delivered to a recipient via a configurable delivery
method. The file is sent to a translation vendor where the XML is translated into a target language. When the
updated file is imported back into STEP, all of the translated values are brought into their appropriate attributes.
The method of XML translation that is most often employed involves a STEP user sending an XML export file to a
translation vendor. The XML will be read by the vendor's XML parser, and the information stored in their
translation memory. The vendor's specific methodology, such as reading XML, sending content to an in-country
linguist, QCing the linguist's work, re-importing the content into the vendor's own tool, etc., will process that
translation task and send the content back to the STEP user to be imported.

The STEPXML Translation also works best when sending content to a vendor that uses a translation memory tool.
For translation work being sent to a vendor that does not have a translation memory tool, an Excel export may be
the better option. For more information on the structured Excel translation export, see the Structured Excel
Translation documentation.

The following objects can be extracted into an XML file for translation:

« Data objects, or objects that contain usable customer data

« Product values

« Classifications

« Freetextcellsintables

» Indexwords

« Asset names (names of images and documents, for example)
« Setup objects, or objects that help organize the data objects

« Asset names (names of images and documents, for example)

« LOVs

o LOV names

« Attribute names (including meta-attributes on attributes)

Itis important to note that setup objects are not under revision control and, therefore, do not require approval to be
exported for translation. Also, attributes and LOV's do not contain any information about translation status and
relations.
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Structured Translation Export to XML
A structured translation extraction can be started through the Request Translation Wizard method.

To start a structured translation XML export, click the File menu, point to Translate in the dropdown, and then
select Data Objects or Setup Objects.

File n View Mavigate Format Maintain Window Help

Translatee : Data Ohjects..e

Import : Setup Objects...

Export : Manual Excel Translation Export
7 Reports @] Import Translation...

Bulk Update 3 Change Translation

Once a user has gone through the Request Translation Wizard this process initiates, they will be able to retrieve
their translation file in the Background Processes tab. These steps are covered in detail in the Starting a
Structured Translation documentation.

For more information about translating setup objects, review the Structured Translation for Setup Objects
documentation.

Useful Facts About Translation XML

XML Translation Export

When a product hierarchy is exported for translation as an XML file, all attribute values and free text cells are
analyzed by STEP's validation to identify the objects that need translation. This information is displayed in the
Feedback step of the Request Translation Wizard.

Tagging of Translatable Text

The export process results in an XML file in which content that appears between the <TranslatableText> tags
contain the attribute values and free text cell values that need translation.

Tagging of Partial Translation

The first time a product is translated into a target language, all language dependent values are extracted.
However, the next time that product is exported for translation into the same target language, only new or changed
values are extracted and appear between <TranslatableText> tags in the exported XML file. This is called partial
translation.

Note: If one value in a multi-valued attribute is modified in the source language, then that attribute goes into Re-
Translation Needed status and all values in the attribute will be extracted for translation.

Translation of Free Text Cells in Tables

Using the structured translation method, you can translate free text cells in tables if the table type in question has
been pre-defined as language dependent.
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Structured Excel Translation

This topic provides an overview of the basics of exporting translation data into a Microsoft® Excel file using the
structured translation method. In this guide, users will learn which objects can be exported into an Excel document
for translation, where in the workbench a structured Excel translation export can be started, and how to read an
Excel translation export document.

Exporting translation data into an Excel file using the structured translation method enables manual translation of
content within an Excel file. When the translation has been completed, the updated Excel file can then be imported
back into STEP, bringing all of the translated values into their appropriate attribute.

Of the three methods available to extract content from STEP for translation, the structured Excel translation
method is best deployed when:

« thereis a small amount of content to be translated

« the translation vendor does not make use of a translation memory tool

If either of these criteria are not met, the structured XML translation export is often the better option. For more
information on this, see the Structured XML Translation documentation.

One potential drawback to this translation method is that there is a greater chance of introducing data
inconsistency into the object being translated. This stems from the fact that the translated values are entered
manually by the translation vendor; adding the data correctly requires additional care to be taken by the user.
Further, special characters like the greater-than and less-than symbols (> and <, respectively), double and single
quotes, or the double prime (to denote lengths measured in inches), must be mapped in STEP prior to export. If
this is not done, the file is likely to error on import.

The following objects can be extracted into an Excel file for translation:

Data objects, or objects that contain usable customer data:

o Product values
o Classifications
o Product

« Asset names (names of images and documents, for example)

Setup objects, or objects like LOVs and attribute names that help organize the data objects, cannot be exported
to an Excel using the structured translation process. The Manual Excel Translation Export is the only method
available to bring these objects into an Excel file.

Note: Free Text cells in tables cannot make use of the Excel translation method. To translate this object type, the
structured XML translation or manual translation method should be used instead.

For more information on which objects can make use of which translation methods, see the Translations
documentation.
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Excel Translation Export

An Excel translation extraction can be started either through the structured Request Translation Wizard
method, or by selecting the Manual Excel Translation Export option. For more information on the Manual Excel
Translation Export option, see the Starting a Manual Excel Translation Export documentation.

To start a structured Excel translation from the File menu, first point to Translate and then select Data Objects.

Filen View Mavigate Format Maintain Window Help

Tranrslatea > Data Ohbj ects.a

Import Setup Objects...

Export Manual Excel Translation Export
7 Reports @] Import Translation...

Bulk Update Change Translation

Once a user has gone through the Request Translation wizard this process initiates, they will be able to retrieve
their translation file in the Background Processes tab. These steps are covered in detail in the Starting a
Structured Translation documentation.

It is important to note that LOVs, units, and attribute names, also called setup data, cannot be translated within the
structured Request Translation wizard method of exporting translatable content to an Excel file. They can be
exported for translation using either the manual translation method, or by executing a Manual Excel Translation
Export.

See the table below for a breakdown of which objects can be exported using the structured and manual Excel
translation export methods.

Translatable Object Structured Excel Manual Excel
Translation Translation

Products, classifications, and image and document o o

names

Product values - -

LOVs X o

Attribute names x o

Units X o

For more on translating setup objects, see the Structured Translation for Setup Objects documentation.
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Translation Excel File Features

The Excel file features a color-coded cell format that quickly alerts the user to each element's status. Below is a
sample of what a user might find in an exported Excel file:

(ol
A E | C =
Product: Battery 3638

3

4 Source: English Target: German
5 1D Battery 3638 Battery 3638

E |Name Battery 3535 Battery 3635

7 | Text attribute [text{’ This battery can last forever

o |Attribute 1 [text{110i

9 Key words Jtext{500

10

11 Product: Battery 4242

12 Source: English Target: German
13 1D Battery 4242 Battery 4242

14 |IName Battery 4242 Battery 4242

15 | Text attribute [text{ This battery cannot last for ever and ever
16 |Attribute 1 [text{110i =
17 | Key worids Jte xt{500

18

10

M 4 » H[%Translation sheet / | 4] | LI &

There are only four cell-shading colors a user may encounter in an Excel export file:

Background color Description

Blue The product name

Green Product information to be translated

Yellow Product information that does not need translation

White Product information that has already been translated and approved

The first time a product is translated into a target language, all values are extracted; however, the next time the
same product is exported for translation into the same target language, only new or changed values are extracted.

If one value in a multi-valued attribute is modified in the source language, then all values are extracted for
translation again.
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To translate all values again regardless of their previous translation status, on the Status tab, under Translation,
in the Status column, select Re-translation Needed.

Excel Translation Import

When you import an Excel translation file, the translated values are imported into the STEP database. The
structured translation process controls the entire import process, regardless of how the Excel file was exported.
For more information on importing Excel files generated through the Request Translation wizard, see the
Importing Translation Excel Files documentation.
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Starting a Structured Translation

This topic describes, step-by-step, how to initiate a structured translation export of STEP content into an Excel or
XML file. Users who read and understand this topic should be able to produce a file suitable to send to a third-party
translation vendor for translation. Other translation methods supported in STEP are covered in their own topics.

To initiate a structured translation export you must access the Request Translation Wizard. To do so, open the
File dropdown from the menu bar, select Translation, and then click Data Objects... (initiating an export for
Setup Objects is covered in the Structured Translation for Setup Objects documentation).

File n Wiew Mavigate Format Maintain Window Help

Translatee ; Diata ijects..a

Import : Setup Objects...

Export ; Manual Excel Translation Export
il Reports @] Import Translation...

Bulk Update ; Change Translation

The Request Translation Wizard guides the user through five steps that enable the user to adapt the translation
export to their specific requirements.

© Stibo Systems - Confidential - Release 9.2-MP3 (October 25, 2019) 21



Step 1 - Object Selection

Steps Object Selection
1. Object Sealection Selection
2. Select Target Language (@) From Root Node
3. Feedback Root Node 88723-12 (100014)
4. Delivery (") From List
9. Schedule Extract List File
File Contains Product IDs
(") From Collection
Collection

Refresh Autormatically

Filter Options

Include Mot Translated Re-Translation Meeded

Approval Requirement Completely Approved Source

Include Super Types | Products

Include Object Types <Al object types=

]
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Finish Cancel

The first step in the Request Translation Wizard is Object Selection. In this step, the user selects which objects
should be included in the translation export, and from where in STEP the objects should be pulled. There are two

sections in this screen, each with a number of options included within.

In the Selection portion of the Object Selection step, the user indicates from where in STEP the content to be

translated should be pulled. There are three ways to select that content.

Selection
(®) From Root Node
Root Mode 88723-12 (100914)
() From List
List File
File Contains Product ID=s
() From Collection
Collection
Refresh Automatically
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« From Root Node: For importing objects directly from the Tree. If the user has started the Request
Translation Wizard while standing on an object in the Tree, that object will pre-populate the Root Node
field. If the user wishes to change the selection, clicking the [ button will bring up a screen allowing the user
to either Browse the Tree for the object, or Search for the object by typing the sought-for object directly into
the search field.

« From List: Forimporting a file with data to be translated. This is different from the structured translation
import function (covered in detail in the Importing Translation Excel Files documentation and the Importing
Translation XML files documentation) in that the file being imported does not contain already-translated
content. In the field entitled List File, click the ™ button to browse or search your computer's folders for the
appropriate file. In the List Contains field, click inside the field to display a dropdown. Select from the listed
options whether the data being imported contains Product IDs, Product Names, Classification IDs,
Classification Names, Asset IDs, or Asset Names. There is no option to multi-select.

Note: There are no formatting rules for the Excel file you select. If it is a single column of product IDs with no
heading and not other content, that is perfectly acceptable. When you select which kind of object type you plan to
import, STEP will look for valid IDs for those objects, and will import only those for which it can match to a valid ID.

« From Collection: For importing a manually selected grouping of various object types (which can,
potentially, be from multiple super types) grouped in a collection. In the Collection field, click the |;| button
and either browse or search for the collection to be translated. If the collection is based on a search and you
want to ensure that new or amended values in the collection are captured prior to exporting for translation,
click the box beside Refresh Automatically.

In the Filter Options section of the Object Selection step, the user can specify object type and the status of the
objects that should be included in the translation export being created.

Filter Options
Include Mot Translated Re-Translation Needed

Approval Reguirement Completely Approved Source

Include Super Types | Products

Include Object Types <Al object types=

« Include: Users may elect to include or exclude values that are Not Translated or values that have been
amended and are thus designated as Re-Translation Needed. Click the boxes next to each to include them
in the filter. One or the other must be checked to proceed. Otherwise, the Next button will be inactive.

« Approval Requirement: By checking the box beside Completely Approved Source, the user is electing
to enforce the requirement that all objects must be fully approved prior to being translated. By leaving this
option unchecked, the user is waiving the requirement that an object be fully approved to be exported for
translation. With this setting unchecked, objects that are partially approved can be exported, but only data
from the approved workspace will be included in a translation export.
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« Include Super Types: In this field, users may click the dropdown to select which super types should be
translated. This field is only activated after a user has selected one of the prime selection methods in the
Selection section above, and then defined a node, file, or collection from which to start the translation. The
super type options are Products (also the default), Classifications, Assets, or All. Because the Excel
translation method does not allow for mixed super types, if the All option is selected, the Excel will be
unavailable as a translation method in a later step (Delivery).

« Include Object Types: In this field, users may select which object types should be included in the
translation export. This field is only activated after a user has selected one of the prime selection methods in
the Selection section above, and then defined a node, file, or collection from which to start the translation. To

specify which object types to include, click the ™ button. This brings up a Select Object Types window.

32 Select Object Types

() All Object Types

(@) Specify |LE'u'E|1

Search

LT_I‘- LASLETIUNgeEd Frouuc s
Iﬁ‘ External Products q
i Packaging Hierarchy
rj Primary Product Classification
E Product Overrides
El|j Products

Elr_=| Levell

|__=| Level2

- Details

QK Cancel

« All Object Types is the default selection in the Select Object Types window. If the user wishes to
include all object types included under the super type selected in the previous field, there's nothing to
do in this window. If, however, the user wants to include only a subset of object types in their export,
they may select Specify. This activates the Browse and Search tabs that enable users to select the
object types that should be included. To add the object type the user should first select it in either the
Browse or Search tabs, and then click the right-pointing arrow to bring it into the box where all included
object types are collected. Conversely, to remove object types to be included, select the object type
and then click the left-pointing arrow.

« Ifthe user has opted to translate the objects contained inside a collection, the Include Super Types
field should be set to 'All'. If the user wants to include a subset of object types within that collection,
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clicking the ™ beside Include Object Types will bring up a Select Object Types window that
contains the three super types (Products, Classifications, and Assets) from which to select child
objects.

3% Select Object Types

() all Object Types

(®) Spedfy
r_=| Alternate Classifications 4

Assets
[#-IF) Primary Product Classification

= Details

Cancel

Step 2 - Select Target Language

- 21

E] Request Translation =l
Steps Select Target Language
1. Object Selection Translate from English
2. Select Target Language  Select Target Language(s)
3. Feedback [7] Danish
e [ French
5. Schedule Extract
[] German
[] Hebrew

[7] Language Root
[ UK English

Back Mext Finish

Inthe Select Target Language step, the user is prompted to select the language they would like to translate their
content into. Click the language or languages that are applicable and click the Next button. It is also possible to
click the Finish button, which will begin the export process immediately, provided there are no errors.
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Note: If you select multiple languages, the objects listed in the next step, Feedback, will not be accurate. The
data shown on the Feedback screen will be for just one language, not all of the selected languages.

Step 3 - Feedback

'

E] Fequest Translation >
Steps Feedback

1. Object Selection

2. Select Target Language | Report |

3. Feedback
4, Delivery Object Type » [Total Count » [Extracted Count > | 18
5. Schedule Extract TtemFamily 1 1
|ID > [Mame > Reason >
100914 8872312 a:i‘V Mot Translated
I Back J | Mext I | Finish I I Cancel

The Feedback step's primary function is to provide the user with reporting about the objects slated to export so
the user can know what precisely will translate before starting the export. On this screen the user will see listed all
of the objects that will be included in the translation export. The breakdown of this data is captured in two tables.

The first table is the summary of what will be included in the export. This is the data it presents:

« Object Type - The different kinds of object types that will be included in this extraction. In this example, there
is one object type: ItemFamily.

« Total Count - The total count of each object type that will be included in the extraction. In this case, there is
one instance of the ltemFamily object type included in the extraction.

« Extracted Count - The number of each object type that will be included in the translation export.

The second table is a list of all of the objects that will be part of the extraction.

o ID - The STEP ID of the object being translated.
« Name - the STEP name given to the object being translated.

« Reason - The listed reason why it is being included or excluded from the extraction. A green checkmark (
" ) indicates that it will be exported. Ared X ( 3¢ ) indicates that it will not be exported. Below are some of

the reasons a green checkmark will appear or a red X might appear:
. € Up to Date: objects will not be exported

« ' NotTranslated: objects will be exported for translation
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. ¥ Not Approved: objects will not be exported (not applicable if the 'Completely Approved
Source' requirement is unchecked in the Object Selection screen)
. ¥ Notin Approved workspace: objects will not be exported because they are only in the Main

workspace and not the Approved workspace (Regardless of whether the 'Completely Approved
Source' requirement is checked, translation only pulls content from the Approved workspace. If
the object has no data, then the object will not be included in the export)

. ' Re-translation Needed: objects will be exported for translation

. € In Progress: objects will not be exported because they are already being translated

. 3 Invisible in Target: objects are not visible in target language and will not be extracted for
translation
. 3 No translation to source: objects will not be exported because the source>target translation

being requested is invalid. For instance, let us say a translation relation exists for an object from
English to French with English set as the Master language. The user then requests a translation
be started from French to English. Because English is set as the master language for the object
being translated, this object cannot be included in a French to English translation, and the 'No
translation to source' status will display for that object.

. 3 No translatable content: objects will not be exported as there are no values that are language

dependent
The second table in the Feedback screen will display up to 1,000 items. If there are more than 1,000 items, a row
of text will appear in the second table that reads, 'More than 1,000 objects, only first 1,000 is shown...". To see all

the objects, click the Report button in the upper right corner of the Feedback screen. The objects will then be
exported into a single-column CSV file for review.

For each object listed in the CSYV file, there is a + sign (will be included in the export) or a - sign (will not be
included), followed by the reason for why it is or is not included in the export.

This is an example from the CSYV file of an object that will not be extracted for translation. Note the minus sign:

Translation Details
ProductObject TypelncludedReasonReferenced
88723-12 {100514]-ItemFamilﬂn Progress-

This is an example from the CSYV file of an object that will be extracted for translation. Note the plus sign:

Mens T PBG w Class {179925)ltem-Not Approved-
Mens T PGW [MT18403) Item-Not Approved-
Cotton T-Shirts {IEZDB}ItemFamilﬂmt Translated-
18216 L O (181951}Item-In Progress-

Mens T PGS (MT18402)Item-Not Approved-
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If the user already knows they want the translation data exported as an XML file, they may click Finish. However,

if the user wants an Excel file, or the XML file delivered in a format other than the default (file), they must click the
Next button to manually configure the delivery aspects of their export.

Step 4 - Delivery

E] Request Translation @
Steps Delivery
1. Object Selection Translation Method: ;XML F]
b S e Filter spreadsheet: :
3. Feedback
4. Delivery Delivery Method: IEK'::EI S

5. Schedule Extract Skip Verification:

Delivers exported data in a file. You will be notified when the file is ready for download.

Process Name: 18202

I Back || Mext H Finish || Cancel I

In the Delivery step, the user specifies whether their content should be exported into an XML or Excel file, and the
method in which that file should be delivered.

Translation Method - From the dropdown, select either XML or the relevant Excel version

Filter spreadsheet - If either of the Excel versions have been selected from the Translation Method dropdown,
the user may select Filter spreadsheet. This ensures that only the attribute values that require translation are
included in the export (those objects that received the # in the Feedback screen). Objects that do not require

translation (those that received the 3 in the Feedback screen) are excluded when this option is selected.

Delivery Method - Choose one of seven options that determine by what method the user will receive the
exported translation file. Dependent on how a user's specific STEP system has been configured, some of these
options may not be available.

The available export options depend on your system setup. The commonly used delivery methods are:

« Deploy: Delivers afile to a specified directory

« Email: Delivers a file as an email attachment. The user must specify the email address of the recipient, a
subject, and the body text

« File: Delivers afile in the background process. The user is notified when the file is ready for download

« FTP: Delivers afile using file transfer protocol (FTP). The user must specify the host name, user name,
password, and the file name used to deliver the file

« Server Side Delivery: Exports the file into a folder located on the Application Server of the STEP system.
The file is only delivered if the specified path has read / write access on the server
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« SFTP: Delivers afile using the Secure File Transfer Protocol (SFTP). The user must specify the host name,
user name, password, and file name

« Websphere Commerce Import: Depends on a user's system setup

Check the box for Skip Verification if you are certain that all of the objects listed in the Feedback screen are
correct to export. Checking this box prevents suspension of the export process until a user visits the export's
background process and confirms the export may proceed.

Step 5 - Schedule Extract

E] Request Translation
Steps Schedule Extract
1. Object Selection Start
2. Select Target Language
3. Feedback @) Now
4, Delivery Later
5. Schedule Extract
Weekly
Manthly

Later and repeat

Start now

| Back | Mext | [ Finish || Cancel |

Important: Consider the time zone of the application server compared to that of the workbench (the client) where
the schedule is created or viewed. When scheduling a job, the local time zone is displayed in the workbench, but
the time zone of the server is used to run the background process. Although displayed, the time zone of the client
is not included in the instruction to the server to run the job. This can cause confusion about when the job will run
since the scheduled time is not automatically converted to accommodate potential differences in time zones.

In the Schedule Extract step, the user may select one of the scheduling options for when STEP should proceed
with the translation export.

Now - Clicking Finish initiates the export immediately.

Later - Brings up two additional fields, Start at (hh:mm) and Start on (yyyy-mm-dd). The user sets the time
and date and STEP completes the translation export at the configured time.

Start at (hh:mm): 15:28

Start an (yyyy-mm-dd): | 2016-03-05
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Weekly - Allows the user to create a recurring export to execute once or multiple times a week. The user sets the
time and date to start, the date at which the weekly export will end, and then the day (or days) of the week the
export should run until the configured interval has elapsed. One or all days of the week can be selected.

Start at (hhzmm): 15:28
Start on (yyyy-mm-dd): | 2016-08-05

End on (yyyy-mm-dd):

Ewery: | Mon Sat
Tue un
Wed
Thu

Fri

Monthly - Allows users to set a recurring translation export once a month. The user sets the time and date to start,
the date at which the weekly export will end, and then a non-date-specific day in the month at which the export (or

days) of the week the export should run until the configured interval has elapsed. For example, the monthly export
can be scheduled for the first Monday of every month.

Start at (hhzmm): 15:28

Start on {yyyy-mm-dd): |2016-08-05

End on (yyyy-mm-dd):

Ewvery: First -

Monday -

Later and repeat - Allows users to create a recurring export that can be auto-initiated multiple times a day. In
addition to the time and date fields, the user can set the number of minutes between auto-exports.

Start at (hh:mm): 15:28

Start on (yyyy-mm-dd): |2016-08-05

End on (yyyy-mm-dd):

Ewvery: First -

Monday -

Use the Later and repeat scheduler with caution as it is possible to set up a recurring export as often as every few
minutes. If the intended interval is improperly set, the STEP system can experience negative performance issues.
For instance, if the Delivery Method of the export is set to ship to an FTP for a translation vendor to retrieve, and
the vendor's tasked with processing all files they retrieve, the user could incur unexpected costs.

When the export schedule has been configured, click Finish, and the translation exports will commence according
to the schedule you have set.
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Reviewing Product Status

When a structured translation export process has been initiated, a few final steps must be taken in that export's
background process. If in the Schedule Extract screen you selected Now, a small window will display showing
two options: Go to Process and Close.

i )

E] Starting process 135833 @

Starting process “135833" (Translation).
Process started

| Go to process |[ Close

Click Go to process to go directly to the export's background process. Click Close if you are not able to progress
the translation at that moment. To access the background process directly at a later date, click the BG Processes
tab, expand Translation, and then expand Active Processes. Click on the relevant process and view the Result
section.

If more than one target language is selected, a background process will be created for each target language, each
process creating its own file.

1. The translation produces an Excel file listing all of the objects that are included in the export. These listed
objects are the same objects that displayed on the Feedback screen. To view the spreadsheet, click the disk
icon and follow the prompts.

D Result

Step Query Done

Review outcome of the translation analysis: statusfile_BGP_13500.csw
Do you want to export these products for translation? [ yes |[ Mo |

2. A prompt below the report file asks, "Do you want to export these products for translation?" Click Yes to
proceed with the export. Click No to abort the export. If the user has checked the box for Skip Verification on
the Delivery screen, then the export proceeds directly to generating an export file, and there is no question for
the user to answer.

3. To export the products for translation, click Yes. A zip file is created that contains the data to be translated.

If you click No, the translation export is ended, and the translation status of the selected objects is not changed.

4. Click the Save icon to save the zipped translation file.
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QResdt

Step Wait for Translation
Review outcome of the translation analysis: statusfile_BGP_13500.csv H
Exported translation files: smitranslation_BGP_13500.zip H

s
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Structured Translation for Setup Objects

This guidance outlines how to create translation export files for Setup Objects, which refer to LOVs (or List of
Values), attribute names, and units. Users who read this guidance should be able to create an export file for these
setup objects, and understand how the content is displayed in the XML export file. For information on translating
Data Objects, see the Starting a Structured Translation documentation.

There are two kinds of objects that must be handled differently than all the others: LOVs, attribute names, and
units. In STEP these kinds of objects are classified as setup objects. Setup objects do not register a translation
status, meaning STEP does not track whether they are "Up to date" or "Re-Translation Needed". The primary
reason for this is these objects are rarely translated more than once, negating any value that might come from
tracking their status. For instance, the purpose of an LOV is to provide the user with a pre-set list of options that are
common and recurring. Translating an LOV means that this list of common and recurring dropdown values is
available in each target language. If the LOV is being translated again and again, it means the values in that LOV
are either being changed or new values added frequently. If that is the case, it's likely the object should not be an
LOV but rather a multi-valued attribute.

Because STEP does not track changes to setup objects, users must manually track any changes made to these
objects.

Note: Although LOVs are classified as setup objects, users are able to track the translation status of LOVs.

Before setup objects can be exported for translation, some criteria must be met:

« Both LOVs and attribute names must have a language dimension dependency.

« LOVs must be configured so that the values that comprise them have IDs.

If these criteria are not met, these objects cannot be exported for translation. If these criteria are met, then they can
be exported for translation either by using a Manual Excel Translation export or through creation of an XML file
using the structures translation method.

Generating Translation Export Files for Setup Objects

The process required to initiate translation exports for setup objects is not significantly different from the process
for data objects. With that in mind, listed below are the differences to consider when initiating translations for setup
objects that make the process different from that of data objects.

Exporting to XML

1. Ensure that the context is set on the correct source language context.

2. Fromthe File menu, click Translate, and then select Setup Objects.
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-de'.r - USERE@http://doc-dev:80 - STEPworkbench

dit View Mavigate Format Maintain Window Help
Translate 9 r
Import !
Export !
Reports

Bulk Update !

Data Objects...

Setup Objects... B

Manual Excel Translation Export
b Import Translation...

Change Translation

3. Onthe Object Selection step, in the Selection area, users may select either the From Root Node or From
Collection option. If you have navigated to the correct Attribute or LOV in the System Setup tab, then the Root

4.

Node field will be pre-populated with that object. Otherwise,

click the ellipsis button ([ZJ) and navigate to the

attribute or LOV group that you want to export for translation, and then click Next.

-

E] Request Translation

1

| &= ]
Steps Object Selection
1. Object Selection Selection
2. SelectTargetlanguage | g From Root Node
Lotz Root Mode Drinks (Drinks) E]
4, Deli
mery From List

5. Schedule Extract

List File

File Contains Product IDs

(7 From Collection
Collection
Refresh Automatically

Filter Options
Indude

Approval Requirement Completely

Incude Super Types All

Include Object Types

Mot Translated

Re-Translation Needed

Approved Source

<Al object types=

Cancel

In the Select Target Language(s) step, select a target language, and then click Next. It is recommended that
only one target language is selected for each export of Setup Data because if two or more languages are

selected, the Feedback screen will display no results.
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You may notice that if certain target languages are selected, additional languages will appear in brackets to the
right of that language. If one language is used in two or more contexts (for example, the French language used
in both the France_French context and the Belgium_French context), then all contexts associated with that
language will be displayed in brackets.

5. The feedback screen provides you an overview of the items that have been extracted for translation. Because
setup objects are not under revision control, no translation statuses will display. In the Reason column, only
the value "Unknown" will appear.

i =

E] Request Translation @
Steps Feedback

1. Object Selection

2. Select Target Language Report

3. Feedback
4, Delivery Object Type » [Total Count » [Extracted Count s
5. Schedule Extract Domains 2 Z
IC * [Mame * |Reason >
Coffee {Coffee) o Unknown
EnergyDrinkLOV {EnergyDrinkLOV) o Unknown
I Back I|§ Mext §|I Finish II Cance

6. InDelivery, select a delivery method, and then click Finish.

The structured translation will then export the data into an XML file.

Note: Setup objects can not be exported into an Excel file using the structured translation method.

XML Export of Setup Data

LOV

Displayed below is an example of an LOV and its three component values exported for translation. In this case, the
LOV name is Colors, the target language is German, and the values (highlighted in yellow) are Yellow, Green,
and Red. In this instance, these values are to be translated into German.

<STEP-ProductInformationTranslation ExportTime="2013-03-27 10:06:21"
ExportContext="EN All All" ContextID="EN All All"

WorkspaceID="Main" wfmProcessTemplateName="Translation"
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wfmProcessID="BGP 768298" translationTarget="German"
PendingFileName="translation.xml">

<ListsOfValues>

<ListOfValue ID="Colors" UseValuelID="true" AllowUserValueAddition="false"
ParentID="List Of Values group root">

<Name>Colors</Name>

<Validation InputMask="" MaxLength="100" MaxValue="" MinValue=""
BaseType="text"/>

<DimensionLink DimensionID="Language"/>

<Value ID="634592"
QualifierID="en"><TranslatableText>Yellow</TranslatableText></Value>

<Value ID="634593"
QualifierID="en"><TranslatableText>Green</TranslatableText></Value>

<Value ID="634594"
QualifierID="en"><TranslatableText>Red</TranslatableText></Value>

</ListOfValue>
</ListsOfValues>
</STEP-ProductInformation>

Next, a translation vendor would receive this data, translate the data, and then send the updated XML file with the
translated values back to user. Subject to how the workflow has been configured between the user and the
translation vendor, the updated XML file is then imported back into STEP, and the translation of the setup data is
complete.

Attribute Name

Displayed below is an example of an attribute name and an attribute metadata value exported for translation (the
text to be translated is highlighted in yellow). In this case, the attribute name is Color Attribute, and the metadata
attribute is Description, for which the value is This color attribute is supposed to be used for cars.

<STEP-ProductInformationTranslation ExportTime="2013-03-27 10:06:21"
ExportContext="EN All All" ContextID="EN All All"

WorkspaceID="Main" wfmProcessTemplateName="Translation"

wfmProcessID="BGP_ 768299" translationTarget="German"
PendingFileName="translation.xml">

<AttributeList>

<Attribute ID="Color" MultiValued="false" ProductMode="Property"
FullTextIndexed="false" ExternallyMaintained="true"

Derived="false" HierarchicalFiltering="false" Selected="true"
Referenced="true">

<Name><TranslatableText>Color Attribute</TranslatableText></Name>
<ListOfValuelink ListOfValueID="Colorsl"/>

<DimensionLink DimensionID="Language"/>
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<MetaData>
<Value AttributeID="Description"><TranslatableText>This color attribute is

supposed to be used for cars</TranslatableText></Value>

</MetaData>

<AttributeGroupLink AttributeGroupID="AAKAl"/>

<UserTypelLink UserTypelID="Product"/>

<UserTypelLink UserTypeID="LATS TEST OT"/>

</Attribute>
</AttributelList>
</STEP-ProductInformation>

As with the LOV example, a translation vendor would receive this attribute name data, translate it, and then send
the updated XML file with the translated values back to user. Subject to how the workflow has been configured
between the user and the translation vendor, the updated XML file would then be imported back into STEP. The
translation of the setup data is then complete.
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Starting a Manual Excel Translation Export

This guide covers how to generate a Manual Excel Translation Export, which is the translation export method best
used when users need to send a very limited amount of content to a vendor for translation, or when exporting
Setup Objects into an Excel file when XML is not a suitable option.

In most cases, creating an Excel translation file through the structured translation process (File > Translate > Data
Objects) is the correct method when an Excel translation export file is required. The Manual Excel Translation
Export method is best used in a limited number of use cases.

Manual Excel Translation Export is a translation method best suited for instances when:

« thereis an extremely limited amount of content to translate

« the translator does not have access to either STEP or a third-party translation tool

« the objects to be translated are setup objects (attribute names, LOVs, and units)

Note: Forindex words, attribute groups, LOV groups, and unit groups, users creating Excel files using the
Manual Excel Translation Export will need to select, one-by-one, all objects to be included in the export file
because selecting the Recursive option will not bring in all child objects for these objects.

Often, the Manual Excel Translation Export process is used in coordination with the translation vendor to correct
an error or process a late addition. Because this translation method represents the most straightforward way to
export a limited number of objects into a single target language, it is considered a good route to efficiently handle
small issues that arise following shipment of a larger translation file.

To Export an Excel File Manually for Translation

To create a Manual Excel Translation Export, open the File menu, point to Translate, and then click Manual
Excel Translation Export.

b 44 | -dev - USERE@http://doc-dev:B0 - 5TEPworkbench
Edit Vi avigate Format Maintain Window Help

Translate r Data Objects...

Import ! Setup Objects...

Export ' q Manual Excel Translation Export
# Reports b Import Translation...

Bulk Update ! Change Translation

Schedule Category Profiling || « D

The Excel Translation Export wizard displays.
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Step 1 - Select Objects

E! Excel Translation Export @
Steps Select Objects

1. Select Objects iis] ¥ [Name » 'Ol:-jectTypE *

2. Select Language > | Add Dt:-jéu:'t(sj-

3. Select Format

[ Recursive

Finish Cancel

m
(Ll
-~
T
=

In the Select Objects step, the user may select which objects should be included in the Excel translation file being
generated.

If an object has already been selected when initiating the Excel Translation Export, that object will appear pre-
populated as one of the objects in this list. If the object is included in error, be sure to remove it by right-clicking the
object and then selecting Remove Object from the list of options that appear.

1. Click the blue-shaded Add Object(s) text and then, in the Select Additional Nodes for Excel Translation
window that displays, use either the Browse or Search functions to locate and select the objects you want to

translate.

P

E Select Additional Modes for Excel Translation @

Browse m

& Advanced @

Mame

2. Additionally, be sure to add a check to the checkbox beside Recursive if all objects that are 'children’ to the
selected 'parent’ object should also be included in the Excel translation export.
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P

E] Excel Translation Export @
Steps Select Objects
1. Select Objects 1D ¥ [Mame * |DObjectType »
2. Select Language » | Add Ut:-jéu:t(s}
3. Select Format
[ Recursive
Ba ext Finis Cancel |

Step 2 - Select Language

The Manual Excel Translation Export allows for one language to be targeted for each export file produced. The
Select Language step allows the user to choose either a source language or a target language as the language

they export the Excel to translate into.

I

E] Excel Translation Export

Steps

Select Language

1. Select Objects
2. Select Language
3. Select Format

The language for the selected object(s) is English
Select a Source or a Target Language for translation.

-

(]

“) Source Language  |English
© Targetlanguage  |French v
I Back I I Mext I I Finish I I Cancel

The first line of text in this window ("The language for the...") informs the user what the source language for the
selected objectis. This is determined entirely by what context STEP is set to at that moment. In most cases, the
source language will be correctly set based on the context, and only the target language will need to be chosen.

However, if the user decides to select Source Language and then select a language different from the context
language, the language appearing in the Target Language field will revert from whatever it's set on to the
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context-driven source language. As an example, if the context is set to English, but a user changes the source via
the Source Language field to French, the Target Language value will automatically change to English. In effect,
itis not possible to set both the source and target to a language that is not set by the context.

Step 3 - Select Format

In the final step in the Manual Excel Translation Export, the user selects which kind of Excel document the data
should be exported into.

P =

E] Excel Translation Export @
Steps Select Format
1. Select Objects
2, Select Language
3. select Format
Export Format Excel 97,2003 -
Back Next | [ Finish I Cancel

Click the Export Format dropdown list and select the relevant Excel format. The choice is between Excel
documents from the Microsoft Office 97, XP, 2003 versions, or Excel 97 and beyond. It is recommended that users
use the newest, supportable versions of Excel. File errors may occur during different STEP processes if using a
template set to an older Excel version.

Then click Finish.

A Save window will appear prompting the user to select the location where the Excel document should be saved.
When you have selected the destination location and clicked Save, the export completes, and the exported Excel
document will be available.

The Excel file you exported will look something like this:

© Stibo Systems - Confidential - Release 9.2-MP3 (October 25, 2019) 41



M| =

|| o
el e w|ee| ~ oo

13
14
15
16
17
18
19
20
21
22
23

A

B

StiboSystems

MASTER DATA MANAGEMENT

C

[This sheet is a 5tibo Systems translation excel sheet. Please do not change the structure of the sheet. |

Product: Cotton T-Shirts

Source: English

Target: French

ID 18209 "18209
Name Cotton T-Shirts Cotton T-Shirts
value a value a
Attribute A, Country Root [text] value b value b
value ¢ value ¢
Brand Owner [text{100)] HanesBrands HanesBrands
Secondary Color [text{100}] Red Rouge
Country of Origin [text{100]] CHIMNA, CHIMNA
The Hanes Beefy-T T-Shirt For over 35 years, it has set
. e the standard for T-shirt comfort and quality. Today it's
Family Description [text(2000]] better than ever, offering greater dur;bilityyand Ie;ra
shrinkage than you'll get with ordinary tees.
150Date [iscdate] 2014-05-04 2014-05-04
Lead Time [integer] 2dy 2 (unece_unit. DAY
Manufacturer Name [text{100]] HanesBrands HanesBrands
Manufacturer Warranty [text{200])] 6 months on workmanship and materials
Brand Name [text{100}] Hanes Hanes
Material [text|{100)] Yahoo
Product Name [text{10000)] abc MName 1
Selling Unit of Measure [text{100)] EA EA
Selling Unit of Measure Qty [integer] 1 M
Provider GLN [text{100]] 1234567891234 1234567891234

The translation work can be done directly in the Excel file and then imported back into STEP.

Important: Special characters like the greater-than and less-than symbols (> and <, respectively), double and
single quotes, or the double prime (to denote lengths measured in inches), must be mapped in STEP prior to
exporting an Excel file using this method. If this is not done, the file will error on import.

For more information on manually translating content in an Excel file, see the Manually Translating XML and Excel
Files documentation. For information related to importing translation Excel files, see the Importing Translation
Excel Files documentation.
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Manual Translation

This topic covers the third method of translation content in the system, manual translation. This topic covers how
a user can translate content in the workbench by adding content directly into the attribute for the target language.

Manual translation is only appropriate when two criteria have been met:

« translators are given direct access to the system

« the amount of content to be translated is not substantial

If either of these criteria are not met, the structured translation process is likely to be a better option.

As an example of an instance where manual translation might be a good option, Company Z sells t-shirts. All of
their product information is translated and up to date. Marketing sends a directive that a word used in the product
description for one t-shirt brand needs to be changed for the US and all other global markets. As this work is very
limited in scope, manual translation can be a viable and potentially fast method to approach this challenge. In this
example, the user would access the product in question, visit each language for that product, and update the
relevant description for each.

Executing a Manual Translation

1. Findthe objectin the Tree. In this example, the product to have attribute values translated is 18210 M B.

¢4 Context |Engiih US

- [Z2] ETIM Artide Groups
-..£9 GPC_Root
--E, Index Words
=-[[Z] Primary Product Hierarchy
L—‘_}Fj Products
Elr_=| Apparel
E}|'_=| Upper Body Wear
E|r_=| T-shirts

=gl T-shirts Items
- 12-GGKTS

. 135442 — 12-GGKT9
- il 88723-12

E Any New Product

- jili Cotton T-Shirts

™ New Product 1234
M 15016L0

- 15710 M B

Tree

[ STEP Worlflow " Bookmarks

.....
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2. Select the target language you would like to view from the Context dropdown. If, for instance, the user wants
to make a change to the French translation of an attribute, they would select the French FR language from this
dropdown.

File Edit View Mavigate Format Maintain

:z Context iFrenn:h FR.
: French FR.
English LIS
-5 {dlsrael Hebrew
-5 (gDanish DK

I:I {gEnglish UK

r_=| adFrench Belgium

[T C French Canada
mﬁ afCGErMany German -

m

3. Clickon Translation Mode. Translation mode displays an object as it exists in two languages, typically the
source and the target. Clicking on Translation Mode will display the target language you chose via the Context,
and the source language will display, by default, as English.

File Edit View Mavigate Format Maintain Window Help

E! Context |Engish US v | (™ URL ]editor='1009148&workspaceid=Main dﬁkﬂ [ @) Goto [ miName -

4. When you switch to Translation Mode, you may receive an instruction dialog that reads like this:

32 Message

Q Please select source language

If you see this, follow step four (below), and select the desired source language. Your system will remember
this selection and display it as the source language in Translation Mode until it is changed or the system cache
is cleared.

5. To select or change the source language, click View in the File menu, and then Source. In the dropdown that
displays, all available languages that have been designated on your system as either a source or a target will
be listed. Select the relevant source language from these.
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Context
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Filter
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Select version
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v UK English )

German

French
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Hebrew
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In this example, we have French displaying as the target language on the Product Translation tab (notice the
French FR displaying in the Context field), and Approved UK English as the source language. The 'Approved'
in 'Approved UK English' references the fact that content to be translated, whether manually or through a
structured export, comes from the approved workspace. Attributes that require translation are shaded green.
In this screenshot, the Long Description attribute is shaded green and has a value in the Approved UK English
column but none in the French column. The green shading is the user's prompt to add a translated value for
that attribute. In this example, the attribute needs a French language value.

STEP Worlflow

E! Context |French FR « | e (¥ URL | +English&editar="Translation& E ﬂ E oz}l Goto | ID/Name >
< 18210 M B rev.0.25 - Product Translation “p
g Primary Product Hierarchy A BEEL TR TEGHENGNGE | References || Referenced By || Tables
) [0 Products =
? Elrj Apparel
E -0 Upper E_Od? Wear » > |Approved UK English » |French
vl =3 T-shirts > | |Attributey ~
— [l Product Linking Test S Attribute Z
ol =+ T-shirts Items > | attwithLangDepLOV
g -l 8872312 > | |Avalabilty End 2015-10-01 11:41:37 2015-10-01 11:41:37
@ =il Cotton T-Shirts > Backplate Diameter (Cm)
gl @110 me > Backplate Diameter (In)
e E 12;1; ;% > Brand Owner HanesBrands HanesBrands
m -
| . o . |T-shirt, short sleeve,
: a 18216 L 0O > Bréve Description Article Beefy-T, Mens M, Royal Blue
=2 a Mens T PBO > B Capaciy
& -\ Mens T PBG > | lcost 6.35 § 6.35
E -\ Mens T PGS > | |Cost Effective Date 2014-12-16 00:00:01 2014-12-16 00:00:01
& - Mens T PGW > | |Cost Expiration Date 2016-12-16 13:41:02 2016-12-16 13:41:02
| - Mens T POY > | |Couleur Primaire Gray Moir
B - Mens T PBO > | |Couleur Secondaire Red Rouge
% -\ Mens T PBG > | |Country of Origin CHIMA CHINA
5 -\ Mens T PGS v |2 | Description, Web v
[} Krrme T TICLAD
P« > < >
REBGI‘;' --Illl

7. Toadd a value, the user must click into the value cell for the appropriate attribute under the green-shaded
target language column, and then type or paste in the translated value.
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18210 M B rev.0.25 - Product Translation
| Primary Product Hierarchy ~ References || Referenced By || Tables
= [T Products "
? Eifl Apparel View: Show all -
E E—}F_=| Upper B’_ﬂd? Wear > * |Approved UK English * |French >
& E-E@ Tshits > | |attribute N A
=] -~ Prud.uct Linking Test > | |AttributeY
ol E- T-shirts Items 5 Attribute Z
i CERseT212 > | |attwithLangDepLOV
g =il Cotton T-Shirts > | |Avaiability End 2015-10-01 11:41:37 2015-10-01 11:41:37
El E :gﬂg 'L': > Backplate Diameter (Crm)
" > Backplate Diameter (In)
i E 18213 MO 3 Brand Cuanar HanscsBands HanssBands
Z E 18216 L O T-shirt, short sleeve, T-shirt, manches
% -\ Mens T PBO » Bréve Description Article Beefy-T, Mens M, Royal courtes, Beefy-T,
& -™ Mens T PBG Blue Hommes M, bleu royal
= - Mens T PGS ey
g, - Mens T PGW > | lcost 6.35 § 6.35 §
2] -\ Mens T POY > | cost Effective Date 2014-12-16 00:00:01 2014-12-16 00:00:01
P - ™ Mens T PBO > | |Cost Expiration Date  |2016-12-16 13:41:02 2016-12-16 13:41:02
El -8 Mens T PBG > | |Couleur Primaire Gray Moir
= - Mens T PGS » | |Couleur Secondaire Red Rouge
& - Mens T PGW > | |country of Origin CHINA CHINA
= -8 Mens T POY > | |Description, web

In this way, most translatable data can be added for all language dependent attributes in all languages. However,
because each language dependent attribute must be amended for each language manually, manual translation is
not recommended for any translation except those with a very limited amount of content to translate.

Note: When using manual translation to translate attributes on the System Setup tab, manual translation using
the Translation mode view only allows you to translate the attribute names, not any of an attribute's description
attributes. However, using Context view, users may manually translate an attribute's description attributes.
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Manually Translating XML and Excel Files

This topic provides a detailed description of how to go into a STEP-exported Excel or XML translation file and add
the translated values directly to the file. The files referenced in this documentation are generated through the
structured translation process (Excel or XML), or the Manual Excel Translation Export (Excel). This process is
different from manual translation in that the work is being done to an exported file rather than directly in STEP. To

review the steps required to generate a translation export file through the structured translation process, see the
Starting a Structured Translation documentation.

When the translation export has been generated (through either the structured translations process or the Manual
Excel Translation Export), the background process will stop at 50% complete.
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181951, en-US = Danish - Background Process

s | (/R

--% MountDocForPlan

£ --% MultipleRevive

E --% ModelistToCollection
w - £ PDF of planned page
= --% PageDone

“; --% Pre-generate thumbnail cache
[ [+-£ Publication Duplication
8 -5 Publish to Website

EI IE%_‘l Purge Dimension Point
E IE%_‘l Purge Matching Data
— --I:@_‘l Purge Revisions
--ﬂ@_‘l RuleSetExporter

_— i L - .- .

--%b Smartsheet Import
--% StateflowDeadline
--% SuspendBGPs

--% TOTAFConvert
[—]% Translation (2)

% Queued Processes
E}--% Active Processes (1)

----- 485 18202, en-US > Hebrew

462 157617, en-US = fr

€§§ [181551, en-US > Danish|
i-48: 135833, en-US > fr
L4tk 110611, enS = fr

£ Ended Processes (1)

¥ Properties

Property ¥ [Value >([ 1
Started by USERE
Id BGP_132235
Description 131951, en-US = Danish
Execution Server doc-dev
== @
ETatis Suspenaed
Created Mon Aug 08 15:58: 21 EDT 2016
@ Execution Report

Leaving query service

Mode selection listwas specified. Will automatically accept analysis result

Parsed translation configuration
Logged on

Updating translation status

1 nodes will be exported for translation
Merging table data

Exported nodes
Translation Export Completed

Delivery started (Mon Aug 08 15:58:23 EDT 2016)
Delivery completed (Mon Aug 08 15:58:23 EDT 2016)

m

E]--% Translation Import
1-20 of 20 -_ Truncate

- £ Unigue Key Processes « “ ? L B =

[#)- & Unlink Object Type

- £ Update actual page from plan % Result

E].J:@_:»I UploadDTPDocument Step Wait for Translation

E]"':%_nl Web UL Asset Pipeline Download Review outcome of the translation analysis: statusfie_BGP_182235.csv &l =

E]--I:@_ﬁ Web UI Download —

<] P | . Exported translation files: ¥mitranslation_BGP_182235.zip Eﬂ
Ready --llll

The Progress bar showing at 50% means the export portion of the translation task is complete, but the translation
task itself is paused until the updated file, with all of the translated values added, is imported. The export generates
a zip file that contains the data, in either an Excel or XML format, to be translated. Typically, this file is sentonto a
translation vendor that does the translation work. In some instances, particularly when there are very few objects
that require translation, it may make sense to translate directly within the exported file rather than sendingitto a
third party.

At the bottom of the background process is a row called Exported translation files. To the right of that is a disk
icon (&l). Clicking the icon will allow the user to access the export file.

Translating in an Excel File

The Excel file features a color-coded cell format that quickly alerts the user to each element's status. Below is a
sample of what a user might find in an exported Excel file:
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Shbattery 3690 Battery 4242xis Read-Only] _iojx
A, E | =
3 Product: Battery 3638
4 Source: English Target: German
5 1D Battery 3635 Battery 3635
E |Name Battery 3635 Battery 3635
7 | Text attribute [text{’ This battery can last forever
o |Attribute 1 [text{110i
9 Key words Jtext{500
10
11 Product: Battery 4242
12 Source: English Target: German
13 [1D Battary 4242 Battery 4242
14 |Name Battery 4242 Battery 4242
15 [Text attribute [text{' Thiz battery cannot last for ever and ever
16 | Attribute 1 [text{110i ==
17 [Key words [text{500
18
10 ¥
4 4 » M[%Translation sheet / 4] | W

There are only four cell-shading colors a user may encounter in an Excel export file:

Background color Description

Blue The product name

Green Product information to be translated

Yellow Product information that does not need translation

White Product information that has already been translated and approved

The only cells where the user should take action are those that are color-coded green.

To translate directly in the Excel export file, click into the green-colored cell in the target language column, and
insert the translated value of the corresponding value appearing in the source language column. Below is an

example of how this will look when completed for one product and one target language:
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14 Product: Battery Backup

15 Source: English Target: German

16 ID 157617 157617

17 [Name Battery Backup Battery Backup

18 Manufacturer Name Rise-N-Shine Rise-N-Shine

19 |New Product [text(1Yes Yes

20 Sales ltem Short De: Never miss a wake-up call | Verpassen Sie nie einen Weckruf |

When translated values have been added for all of the blank green-colored cells in the target language columns,
the user should save the file, remembering to retain the Excel file extension. The file name can be whatever the
user prefers; STEP keys on the ID information inside the Excel, so the file name has no impact on the translation
process. The file is now ready to be imported.

For more information on importing Excel translation files, consult the Importing Translation Excel Files
documentation.

Translating in an XML File

If the user has elected to export an XML file through the structured translation process, the zip file is accessible via
the disk icon (2] ) at the bottom of the background process.

The zipped XML translation export file contains these files:

File Description

preview.css Contains style preview information.

preview.xsl Contains style sheet information for displaying translatable content.

preview.tags Contains tag information.

translation.xml | Contains data to be translated. You can translate directly in the XML file. All fields that can be
translated are tagged
<TranslatableText>.

The file where the manual translation work will be done is in the translation.xml file.

To translate directly in the XML export file, the user replaces the source language content that appears between
the <TranslatableText> tags in the XML file. In the screenshot below, you will find yellow-highlighted text
appearing between two red-boxed <TranslatableText> tags. The text highlighted in yellow is what the user
would replace with the translated value.
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W oo W8 oo B0 i 800 80 o BT B0 B B0 I n MO0 000 n B30 0o W0 00
&4 </Qualifiers>
&5 <Products>
(13 <Product ID="181951" UserTypeIl="Iten"™ ParentID="13203">
&7 <Name QualifierID="std.lang.all"™>

68 | «TranslatableText>18216 L O</TranslatableText></Name>
83[] «Value AttributeID="URL" QualifierID="en-U5">

24 <TranslatableText>http://www.google.con</TranslatableText>

85 </Value></MultiValue><Value AttributelID="CostEffectiveDate” AttributeName=" (CostEffectiwveDat:01</Value><Value Attcior
88 <TranslatableText>T-shirt, short sleeve, Beefy-T, Mens L, Orange</TranslatableText>

87 <i\’al'.1e><\’al'.1e AttributeID="AvailabilityEnd" AttributeName=" (AvailabilityEnd)">2015-10-01 1l:4ttributell="LongltemlrID=
g8 <TranslatableText>lanes Beefy-T short sleeve T-shirt in 100% cotton that resists shrinkage. I<,-"Translat,able'[‘ext,>

B89 </Value><Value Attributell="IsInvoiceUnit" ID="Y¥">¥</Value><Value AttlributeIE="’ListPrice"’ Tnic" AttributeName=" (Lis><\
30 </Product>

91 </Products>

92 </S5TEP-ProductInformationTranslation>

When translated values have replaced all relevant content tagged with <Translatable Text>, the user should save
the file, remembering to retain the XML file extension. As with the Excel file, the file name can be whatever the
user prefers; STEP keys on the ID information inside the XML, so the file name has no impact on the translation
process. The file is now ready to be imported.

For more information on importing XML translation files, consult the Importing Translation XML Files
documentation.
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Asynchronous Translation

Asynchronous translation is a STEP feature that enables customers to configure automated transmission and
receipt of translatable and translated content via a REST API. This method of translating content does not add or
subtract any translation capabilities to or from STEP, but rather facilitates existing translation processes.

For more information on asynchronous translation, see the Asynchronous Translations section of the Data
Integration documentation.
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Importing Translation XML Files

This topic will cover the process of importing a translation XML file into STEP.

Once the translation vendor has completed translation of the submitted objects in an XML file, the XML file can be

imported into STEP. Importing a translation XML file into STEP will bring all of the new translated values into the
appropriate language contexts.

After the user has initiated an import, but before the import is executed by the system, STEP takes a series of
automated steps to ensure the translated content is handled correctly. Prior to executing an import STEP will:

o Check that the XML is valid (not malformed)

« Check that no values in either the source or target language have been modified in STEP since the XML file
was exported

« Check that the imported values match the attribute validation base types in STEP (for instance, if an attribute
restricted to accept only number values is given a free text value, an error is raised)

To start the translation Import Wizard, click File > Translate > Import Translation...

E] ; [y-dev - USERE@http://doc-dev:80 - 5STEPworkbench

Edit ViewgMavigate Format Maintain Window Help

Translate r Data Objects...

Import ! Setup Objects...

Export ' Manual Excel Transla Export
# Reports b Import Translation... P

Bulk Update ! Change Translation

Schedule Category Profiling ”l P .ID
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Step 1 - Select file

E] Translation Import @
Steps Select File
1. Select File C:\Usersbror, STIBO\DesktopiTranslation Files for Importixmltranslation_BGP_181287.zip

2. Import Options
e Look in: Translation Files for Import - ¥ -

-]___ xmltranslation_BGP_181287.zip

File name: xmitranslation_BGP_181287.zip

Files of type: | Zip Files (*.zip), XML Files (*.xml) and Excel Files (*.xds and *.xslx) -

In the Select File step of the Translation Import Wizard, the user must select the XML file they wish to import. To
select the relevant file, navigate in Windows Explorer to the location of your file and select it. Then click Next.

Note: Users may name the import file according to whatever naming convention is most useful to them. The
import process keys entirely off the contents of the file, not the file name, so users have complete freedom in
naming import files. The file must either be an .xml file or a .zip file with an .xml contained inside.

Step 2 - Import Options

r'
E]Translatiu:unlmpu:urt '_2_3_'
Steps Import Options
L. Select File i@ Deliver File to Badkground Process
2. Import Options

~) Import Manually

Details
[ The file was exported from process 21929, en-J5S > f§ (%01)

Bacdk Mext I Finish H Cancel

The first option available on this screen, Deliver File to Background Process, is pre-selected because you
have elected to import an XML file. Deliver File to Background Process is the best option.

If the user selects the Import Manually option, a message in red text will appear in the Details section:

© Stibo Systems - Confidential - Release 9.2-MP3 (October 25, 2019) 54



StiboSystems

MASTER DATA MANAGEMENT

E] Translation Import @
Steps Import Options

1. Select File Deliver File to Background Process

2. Import Options =~

@ Import Manually

Details

The file was exported from workflow 21929, endJs = fr (361).
Importing this file manually may mean that the process will not
terminate since it has not received this file,

| Back

I Finish H Cancel

m

The last sentence states that, "Importing this file manually may mean that the process will not terminate since it has
not received this file." What this means is that because the user intends to import the file manually, the file will not
be delivered to the background process created to export the XML. The background process is paused at 50
percent post-export, and will not advance to completion (100 percent) unless the file is delivered back to the
background process. This means that if the user selected Import Manually, the translated data may be correctly
updated, but the background process will never advance. If the manual import completes with no errors, users
may update the values in the XML file and import it using the structured import. The background process will
complete.

The primary advantage of Import Manually as it relates to XML files is that it allows a user to import verified data
directly into STEP without the added steps of addressing a background process or forcing the data through
STEP's validation process. In practical terms, if a third-party translator has multiple changes to the same
translation, manually importing each updated XML file can be the most efficient way to update the translation
quickly.

With Deliver File to Background Process selected, click Finish. A File Uploaded to Process window
displays with a message like the one below:

<

E! File Uploaded to Process @

The file xmltranslation_BGP_181287.zip has been
delivered to process 21929, en-US = fr (%3)

Goto Process ]| Close I

To check the progress of the import, click Goto Process. This will take the user to the background process
executing the import.

Once the user has accessed the background process, they should see that:

© Stibo Systems - Confidential - Release 9.2-MP3 (October 25, 2019) 55



StiboSystems

MASTER DATA MANAGEMENT

« the Progress bar, which was halfway across and paused at 50 percent, is complete and shows a Done

status.
Description 21929, en-US = fr
Execution Server doc-dev
Siats succeeded
Created .'l."'.l'Ed Jul 20 16:02:09 EDT 2016
Started Wed Jul 20 16:02:29 EDT 2016

— ..

LT i B B R Ea L T TR Pl o e e P

« the final steps listed in the Execution Report section of the background report show that STEP has marked
the "translation of file" complete, and further states that "all pending files have been translated".

D Execution Report

Importtranslation process started: BGP 181296 (Wed Jul 20 16:58:36 EDT 2016)

Splitting table data

Marking translation of file franslation-BGP_181287-frxml’ as completed
Translation of iworkarea/background-processareaTranslation/BGP 181287 /converted xml finished: 0 Errors, 0 Warnings, 0 Infos

All pending files have been franslated.

H 4 1-250f25 | [k 23 [ Save... ] Truncate

To ensure the translated values were updated as planned, the user may select one of the translated objects,
switch the Context to the target language's context, and find one of the values that was set to translate. The

translated value should display.

For information on how to import Excel files, see the Importing Translation Excel Files documentation.

For more information on how to handle errors that may arise during import of a translation file, see the Handling
Translation Errors documentation.
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Importing Translation Excel Files

This topic will cover the process of importing translation Excel files, both via the structured translation process and
through the Manual Excel Translation Export, back into STEP. A successful import will complete a translation task.

When the translation vendor has completed translation of the submitted objects in an Excel document, the Excel
file can be imported into STEP. Importing an Excel file will bring all of the new translated values into STEP in the
appropriate language contexts.

After the user has initiated an import, but before the import is executed by the system, STEP takes a series of
automated steps to ensure the translated content is handled correctly. Prior to executing an import STEP will:
« Check that the Excelfile is intact, meaning no sections have been deleted or amended

« Check that no values in either the source or target language have been modified in STEP since the file was
exported

« Check that the imported values match the attribute validation base types in STEP (for instance, if an attribute
restricted to accept only numerical values is given a free text value, an error is raised)

To start the Import Wizard, click File > Translate > Import Translation...

E] | [y-dev - USERE@http://doc-dev:80 - 5STEPworkbench

Edit Viewghlavigate Format Maintain Window Help

Translate A Data Objects...

Import ! Setup Objects...

Export ! Manual Excel Transla Export
# Reports b Import Translation... P

Bulk Update ! Change Translation

Schedule Category Profiling H > ID
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Step 1 - Select file

E! Translation Import @
Steps Select Fle
1. Select File C:\Users\brer, STIBO\Desktop

2. Import Options
il Look in: Translation Excel Files for Import - F R

_1 Excel Translation_French .:(Is|

File name:

Files of type: | 7ip Files (*.zip), XML Files (= xml) and Excel Files (*.xls and = xsh) =

In the Select File step of the Translation Import Wizard, the user must select the Excel file they wish to import.
Navigate in Windows Explorer to the location of your file and select it. Then click Next.

Note: Users may name the import file according to whatever naming convention is most useful to them. The
import process keys entirely off the contents of the file, not the file name, so users have complete freedom in
naming import files. The file type must be an .xIs or .xslx file.

Step 2 - Import Options

E! Translation Import @
Steps Import Options

1. SelectFile Deliver File to Background Process

2. Import Options

@ Import Manually

Details

| Automatically Approve Imported Translation

| Finish || Cancel |

| Back

m

The Import Options step of the Translation Import process will provide different options depending on whether
the Excel file to be imported was done as part of the structured translation process or as a Manual Excel
Translation Export.

If the import file was initially generated through the structured translation process, both import options, Deliver
File to Background Process and Import Manually, will be available. Make your selection and click Finish.
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If you select Deliver File to Background Process, a message screen will display showing the process number
assigned to the import action, as well as an option to go directly to the background process executing the import.

If the user elects to go to the background process, and there are no errors, they will see that:

« the Progress bar, which was halfway across and "stuck" at 50%, will complete and show a Done status.

10 Buab_ 185 1LLS

Description 179927, en-US = Danish

Execution Server docadau

Progress
Status 30 [alal=T=Tu [T

« thefinal steps listed in the Execution Report will show that STEP has marked the "translation of file"
complete, and states that "all pending files have been translated".

T Execution Report

179927-179927 x5 successfully imported.
Marking translation of file "179927-179927 xl5" as completed
All pending files have been translated.

The user may also select Import Manually for an Excel file generated through the structured translation. If the
import file was initially generated through the Manual Excel Translation Export process, then Import Manually
will be the only available option. After selecting Import Manually, click Finish and the updated values will be
added to the pertinent language. No background process is generated by this action. Any errors that occur will be
surfaced in a dialog that will enable a user to Save, View, or Discard an error report.

Users importing Excel files will have the option to Automatically Approve Imported Translation.

I )

E] Translation Import @

Steps Import Options

1. Select File
2. Import Options

Deliver File to Background Process

@ Import Manually

Detalls

[] Automatically Approve Imported Translation

m

| Back

| Finish || Cancel
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Checking this box automatically changes the status of the object in the target language to Approved once the
import completes. The benefit to checking this box is that it removes the added step of manually approving the
object in the target language after an import. When multiple translations are executed, removing this step can

represent a significant time savings.

To ensure the translated values were updated as planned, the user may switch the Context to the target
language's context and find the values that were in the green-shaded cells. The translated values should appear in
the object record.

In some instances, these processes may generate errors. For more information on the kinds of errors you may
encounter, see the Handling Translation Errors documentation.

© Stibo Systems - Confidential - Release 9.2-MP3 (October 25, 2019) 60



StiboSystems

MASTER DATA MANAGEMENT

Handling Translation Errors

After a translation vendor has completed translation of content, whether in an XML or an Excel file, the file is then
imported back into STEP to complete the translation process. This topic will cover where these errors are
viewable, what sort of errors a user is most likely to encounter, and how best to address those errors. By the end of
this topic, the user should be able to handle most translation errors that may occur.

Most translation import errors occur right after the user has initiated the import process. For more on importing
translation files, see the Importing Translation Excel documentation, or the Importing Translation XML
documentation, whichever is applicable.

Import Error Notifications

STEP makes the user aware of translation import errors in a number of ways, depending on the scenario. If, for
instance, the user is attempting to import a translation that has already been imported, STEP will respond by
displaying a message window entitled Error sheet....

E] Error sheet... @

The impart reported errors and an error sheet
has been created.

-

[ Save ]| View H Discard I

This window will also display if the user has imported an Excel file manually and STEP has detected errors.

When this window appears, the user is given three options:

« Save: This is the best option if the user knows they want to save the error report. When a user clicks the Save
button, a Save As... window displays. Navigate to the place on your computer where you want to store the
Excelfile listing the errors. In the File name: field, add an appropriate title. An Excel file is generated that
describes the errors.

« View: This is the best option if the user is not clear whether they need to save the error report. Clicking the
View button brings up the same Excel error report the Save button generates. Once the user has viewed the
file, they may decide whether to save it or not.

« Discard -- Clicking the Discard button generates no report and initiates no action. The import process also
does not proceed.

The other way that STEP notifies the user that an import has generated errors is in the Execution Report section
of the import background process. When a translation import is initiated in STEP, the automated steps appear in a
list. If, during the course of executing those actions STEP detects an error, the error will be listed in the report.

© Stibo Systems - Confidential - Release 9.2-MP3 (October 25, 2019) 61



StiboSystems

MASTER DATA MANAGEMENT

For instance, if the XML being imported is malformed, meaning the structure of the XML is in the wrong format,
missing an end tag, etc., STEP will generate an error. In the below instance, part of the XML was deleted in error,
saved, and then imported.

¥ Execution Report
Analyse
Import translation process started: BGE_ 181341 (Thu Jul 21 14:28:47 EDT 2016)
Splitting table data

I 22 File tranzlation-BGE 181340-Hebrew xml could not be parsed : Received unexpectad:
class orgxml.sax SAXParseException: Element type "ClassificationReference”
must be followed by either attribute specifications, ™=" ar "f=".

I 22 Translation failed with 1 error

Pending files: 1
1 files are pending.

H 4l 1-260f26 | b [ Save... Trun

Translation imports can import with warnings, where only the values affected by the warnings will not import. All
other values unaffected by warnings willimport with no issues.

]
o
m

Itis also possible to view the Execution Report for in-progress translation imports by finding the relevant Active
Process in the Background Processes tab. To access the background process, click the BG Processes tab,
expand Translation, expand Active Processes, and then select the pertinent process. The Execution Report
generated for that import is viewable.

Excel Error sheet
There are a number of ways to view the Excel file listing the translation import errors:

« Access the background process specific to that import and, if errors are present, click the disk icon ( ) located
in the Error file: row in the Result section.

F Result :
Translated file: xmltranslation_BGP_151340.zip =
Error file: report_BGP_181341.err =l

Importing translated file failed, please correct errors.

For XML, reimport changed XML file. For Excel reimport updated error sheet.

| Done

« Click View or Save when the Error Sheet... pop-up displays upon import.

Below is an example of how the Excel document will be formatted. Only one error is listed in the Validation error
column, though in some instances an error sheet can display multiple errors.
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j exceltranslationerror30188.xls o [ 4
A B | C D |§
1 |This sheet is a Stibo Systems translation excel sheet. Please do not change the structure of the sheet.
2
3 Product: Battery 3638
4 Source: English Target: German Validation error
5 (D Battery 3638 Battery 3638
The source value has been changed since
expart, was:
Text attribute [text{ This battery cannat last forever Diese Batterie kann nicht immer dauern. "This battery cannotlast forever”
IS now
5] "This hgtter\r cannot last forever”
—? hd
A
M 4 » M%Translation sheet [4] | LI i

In this example, the English value "The battery cannotlast forever" was included in the initial translation export into
German. After the translation export but prior to the import, the value was corrected in the English context to be
"The battery cannot last forever". The error was thrown because the English value the STEP validation was
expecting no longer matched the value in STEP. The status for this translation would flip from In Progress to Re-
Translation Needed. To fix this error, a user might consult directly with the translation vendor to determine what
changes, if any, would be required to make the German value accurate based on the updated English value. Once
the German value is deemed correct, the edit can be made directly in the Excel error sheet and then imported.
Following that, the translation status can be manually changed from Re-Translation Needed to Up to Date,
completing the translation.

The Validation error column can contain a number of errors. Below are some of the most common error
messages a user may encounter:

» The Product does not exist

« Valueis not a “humber, integer, fraction...”

« Invalid Unit for Attribute

« The source Value has been deleted since export. The Value was “[value]”

« The target Value has been deleted since export. The Value was “[value]”

« A source Value has been added since export

« Atarget Value has been added since export

« The source Value has been changed since export. The Value was “[value]’

« The target Value has been changed since export. The Value was “[value]”

« The Unit of the source Value has been changed since export. The Value was “[value].”

« The Unit of the target Value has been changed since export. The Value was “[value]”

« The order of multi Values has been altered. Correct the order or delete multi Values in file.

In some cases, handling these errors will require the user to manually change the translation status and then re-
export (as described in the example above). In some instances, users may correct the error directly in the error
sheet and then import the updated error sheet. For instance, if the value is free text, but the attribute only accepts
numerical values, then the user can address this error directly in the error sheet by amending the error and
importing.
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For more information on changing translation status, see the Changing Translation Status and Setup
documentation.
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Changing Translation Status and Setup

This topic covers a series of manual steps users can take to quickly rectify issues that may come up during the
translation process. Whether that means accommodating a late change to a shipped translation, or fixing an
incorrectly set source language, this documentation provides guidance on how to use make these adjustments.
Users who have read and understood the content in this topic will know how best to use the Change Translation
and Change Translation Status features.

Though STEP enables users to automate a number of translation tasks, STEP also provides the user with some
flexibility to manually address errors and late changes. For example, let us say a translation file has come back
from the translation vendor and been imported back into STEP. This automatically puts the object into Up to Date
status. But shortly thereafter, the customer has some late updates. To import these updated values, the object's
status must first be manually changed from Up to Date to In Progress. Once changed, the updated file can be
imported.

Changing the Translation Status

Translation relations, or the link between a source language and a target language, are established automatically
when translation exports are done. In most cases these relations won't need to change, but on rare occasions the
translation relation must be changed manually. Translation relations need to be changed manually when:

« the shipped translation file is corrupt due to a network or hard disk issue. This necessitates resending the
translation export file, which would require manually changing the status from In Progress to Re-
Translation Needed.

« the shipped translation file is missing some content that should have been included. This necessitates
resending the translation export file, which would require manually changing the status from In Progress to
Re-Translation Needed.

To change the translation status, take the following steps:
« Inthe Tree tab, select the object whose status needs to change. Click the Status tab, and then expand the
Translation section by clicking the flipper. Find the translation relation (source language to target language)

where the status needs to be changed, and then click into the cell in the Status column. A dropdown
displays with the available statuses. Select the appropriate status and the change is complete.
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[ Product ” Sub Products ” References " Images & Documents " Commercial ” Fackaging Hierarchvm
®-Revisons e
C-workspsces

% Translation
Master : :Enghsh v:
Source * Target * |Status >
» English French Lp to Date -
@~ Data Pool Subscriptions Re-Translation Needed
In Progress
2+ Data Pool Publications " =
Up to Date

Changing the Source Language

As with the translation status, the source language is established when a translation export is first created and
rarely needs to be changed. But there are some instances where manually changing the source language is the
correct option. For instance, if the user selected French as the source language instead of US English and
identified their error shortly after exporting the translation file, manually changing the source language is the right
option.

To change the source language, take the following steps:

1. Inthe Tree tab, select the object whose source language needs to change. Click the Status tab, and then
expand the Translation section by clicking the flipper. Find the translation relation (source language to target
language) whose source language needs to be changed, and then click into the cell in the Source column.
Selecting a new language completes the task. If the source language has been incorrectly set for one
translation, it likely needs to be changed for all. If this is the case, repeat this step for all applicable translation
relations.
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ynid =108 200&contextid=Context 18id= | [=] [£] . E3 [l coto [1Dimame -

18216 L O rev.0.2 - Status

Commercial || Tables || Category Profile || Proof View State Log Tasks

| Productk ” Sub Products " References Referenced By Images & Documents ]

- Revisions

9 Workspaces
D > [Mame » |Path ¥ ¥

* Main Main Main 0.2
* Approved Approved Approved n.2
& Translation

Master :  Engiish -

Source > [Target » [Status >

In Progress

In Progress

In Progress

In Progress

In Progress
= Approval status in all contexts

- Hidden values

- Diagnostics

Important: Changing the source language for an object is not possible if no translations have previously been
done for the new source language. For example, let us say an object has only one translation relation: English
(source) to German (target). You want to change the source language from English to French. If the object
has not previously been translated into French, French cannot be selected as the new source. In this example,
only German could be a selectable source language.

2. Next, change the translation status from In Progress to Re-Translation Needed.

3. Finally, re-export the newly amended translation because any previous export files will be nullified by the
change of source language.

As with any significant error that occurs in the translation process, it is always recommended practice to
communicate with your translation vendor. Given the specific translation configuration you have established with
the vendor, they may provide useful guidance about how best to rectify the error, including steps they can take on
their side.

Changing the Translation Setup

If multiple objects require a change to either their source language or translation relations, the Translation Setup
tool enables you to change translation relations on many objects in a single step.
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Important: Use the Change Translation Setup tool with care. Changes to the master language or translation
relations can have a major impact on the translations in your system. We recommend using this dialog when you
have, for example, a limited set of objects where you need to change the master language or translation relations.

1. Inthe File menu, click Translate, and then choose Change Translation. The Change Translation Setup
dialog appears.

E} Change Translation Setup >

Input file:

Header lines toignore |0

IDs in file are for: (® Product () Asset () Classification () List Of Values

[] Clear all translation relations (done before above operations)
[] 5et master to French v

Source > [Target > [status >

* |Create tran=zlation relation

2. Inthe Input file field, click the ellipsis button ((...), and then select the relevant text file. The text file must

contain the IDs of all objects whose translation relations and status you want to change.

Important: Only .txt files can be used. A common way to create this file is to export the relevant objects from
STEP into Excel, and then copy and paste the data from that Excel into a .txt file.

3. Ifthere are header lines in the text file that you want the system to ignore, enter the number of header lines in
the Header lines to ignore field. The default setting is 0.

4. FortheIDs in file are for element, select which of the listed object types the IDs in the .txt file refer to. The
Change Translation Setup tool can only take action on one of the listed object types (Product, Asset,
Classification, Lists Of Values) at a time.

5. Check Clear all translation relations if you want to remove all existing translation relations on the matched
objects. In practice, this will remove all translations that have been created for a given object.

6. If youwantto change the source language for the same target language across multiple objects (e.g., all
translations into French), check the box for the Set master to field, select the desired target language that,
and when you click OK, any translation relationships with the selected language as the target language will
swap their current source-target translation relation.
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Note: Though STEP allows users to check both the Clear all translation relations and Set master to
boxes, if you do check both, be advised that only the Clear all translation relations command will be
executed. Set master to is a command to take action on existing translation relations. If you have also
directed STEP to clear all translation relations, Set master to will have no translation relations to take action
on. Because of these restrictions, be sure to only check one or the other.

. Click the Create translation relation text to specify any new translation relation you want to apply to the
objects listed in the .txt file. However, be aware that:
. If Clear all translation relations is checked, all existing translation relations are removed from the
matched products, and the relations specified in this dialog are applied to the matched products.

« IfClear all translation relations is not checked, the existing translation relations on matched products
remain as they are, and the relations specified in this dialog are added to the matched objects.
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Searching for Translation Status

This topic addresses how to search for an object's translation status (Up to date, Re-Translation Needed, etc.)
using the advanced search functionality. By reading through this topic, a user should be able to search for and
locate an object's translation status in the STEP Workbench.

STEP enables users to quickly search for the translation status of a given object using the Advanced Search
capabilities located on the Search tab. Using the Translation Status and Search Below search criteria together,
users can find out not only whether an object's translation into a target language is Up to Date, but, for example,
how many products in a specific context are in Re-translation Needed status.

This functionality may prove useful in a number of common scenarios. For instance, if you know some products
were updated after the translation export was sent for French translation, you may want to alert the translation
vendor so they know to expect updates for those products. To do this, you could run a search of all relevant
products translating from English to French, that are in Re-Translation Needed status. This would provide you
with a reliable list of all products to query with your translation vendor.

Below is a step-by-step description of how to initiate an advanced search for objects by their translation status.

Initiating a translation status search

1. Verify the relevant context has been selected.

m Context |English US B

Correct selection of context is important because it restricts which languages can be searched as you continue
to build the search. More on this in the description for step five.

2. Click the Search tab. The panel below will display in the left navigation panel.
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3. Clickthe Search Criteria Type Selector ( [S==<h ¥) and select Translation Status from the dropdown.

4.

5.

In the Type dropdown, choose the object type you want to search for. The user may choose between these

object types: Classification, Product, Asset, Attribute, and List Of Values.

| Translation Status =
Type: | Product

]

-Langu{Classification

5
O Asset

@ TAttribute
List Of Values

-Translation Status

[ ] Re-Translation Needed

[]1In Progress
[ ]Up to Date

[ ] Mot Translated

In the Language area, select Source language or Target language, and then choose the relevant
language. You may notice that, as default, the source language is set to your current context and grayed out. It
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may be changed, but the moment you select Source Language, the Target Language switches to the language
your context is currently set to.

Search
- [ Translation Stans =] I
Type: :Classiﬁmﬁnn i
rLanguage
(") Source Language | |Enalish
i@ Target Language ;Dutd'l -
Danish 2
- Translation Status Dutch =
English
[] Re-Translation M =
[]In Progress (German
Hebrew
[] Up to Date Language Root
IIK. English
[] Mot Translated

6. Inthe Translation Status area, check one or more of the listed status types you would like to include in your
search. For instance, including the statuses Re-translation Needed and In Progress in your search will bring
up all objects of the object type selected in step four that are currently in either Re-translation Needed or In
Progress status. These are the status options available to include in your search:

Status Description

Re-translation Needed | Master language has been changed since last translation.

Up to Date Master language has not been changed since last translation.
In Progress Translation has been exported, but not yet imported.
Not Translated Object has never been translated.

Note: Checkboxes within the 'Translation Status' area are not available for editing if 'Attribute’ is selected in the
'"Type' dropdown menu.

7. Addthe Search Below search option. The Search Below criteria is required to ensure a complete search
result of objects that meet the configured Translation Status search criteria. To add the Search Below
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search criteria, click the Add Criteria / Operator button ( ), and then click the Search Criteria Type
Selector ( [S==h ¥). Select Search Below from the dropdown.

Search Below

Referenced Assets

Data Containers

Search from List

| Translation Status ]
Search
Search T
H Object Type

Revised Objects Changed Since

Reset Search
Show Details

—

> |

8. Click the ellipsis button to the right of the field to select which node the search should be applied to. Click
'Select' to apply the highlighted node to the search criteria.

| Translation Status =
Search Below  *
’VF'rimary Product Hierarchy (Product hierarchy root) D
3 Reset Search
Search Result
[ Name 5 Search Below... %
Search
E|_:| Products
(-5 Footwear
=5 Safet

|j Head Wear
: rj Qutdoor Apparel and Accesari
--1‘_‘=| Hardware
[+-F5) Displays

& Details

el Select Cancel

Important: To avoid performance slowdowns when using the Translation Status and Search Below criteria
together, users should precisely define which nodes should be selected for Search Below. For example,

selecting a root node can potentially result in poor performance for the entire query.
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9. Click Search.

[] Mot Translated

ER [ Reset ]l Search I

[¥] Up to Date ‘ ‘

10. Ifthe search has generated results, they will display in the Search Results List, located beneath the Add
Criteria / Operator button (|52 7).

[5a [ Rezet ] [ Search ]
Displaying 3 of 3 results Show Details

Mame »
gt

> | . 18207-011 ID = 18207
> 21933 D = 21935
> |.a|321934-24 ID = 21974

-Operations on Entire Result

11. Clicking on any of the objects listed in the search results will take the user directly to the object.

For more information on the search functionality, see the Search documentation in the Getting Started / User
Guide documentation.
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Scheduling a Collection of Objects for Translation

This topic covers the ability to schedule all objects in a collection for translation. In order to understand how this
functionality works, it is beneficial to ascertain the actions that take place:

« Anevent processor plugin (the Asynchronous Translation Message Processor) processes events for the
objects included in the collection.

« Togenerate an event per object in the collection, a bulk update action (configured with a business action that
can generate derived events) must be run on the collection.

« Once the bulk update action is run, the event processor plugin will read the events dependent on the
scheduling configuration of the event processor. Also, the event processor can be configured to batch together
the events, resulting in a reduced number of translation files.

To schedule a collection of objects for translation, there are several requirements (specifically, creating and/or
configuring components within System Setup) that need to take place prior to scheduling the collection for
translation. While the majority of these actions do not need to be performed in the order they are discussed, users
may find it beneficial to do so. These include:

« Creating a derived event

« Creating and configuring an asynchronous translation service

« Creating and configuring an event processor

« Creating and configuring a business action

« Creating a collection

« Running a bulk update

Create a derived event

In the example below, a derived event named 'AsyncTrans_English_to_French' has been created. This derived
event will be selected later in this topic when configuring the business action and the event processor.
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System Setup € Derived Events -
LovTrans il Derived Events
[+-[5] GDSMReceiverRestBusinessAction: »
=|-[5] Global Business Rules > |Psset Keywords Event

ﬁ Default Audit Business Action I > Bsycnirans English to_ French
[fﬁ; Actions » SErt_Transl-aﬁun_LiF_'l'u_Fr [I
= [£5] Conditions

> Libraries
L. ather

----- [5] Inbound Integration Endpoints

----- (5] Match Codes and Matching Algoritl

+-[5] Outbound Integration Endpaints

[+-(5] PDS Inbound Setup Group

[+-(75] PDS Qutbound Setup Group

----- Status Flags

----- SufficencyDataContainer

[+-[5] Web Uls

----- 5] Workflow Profiles

----- (5] Workflows

> > |A|:I|:I Derived Event Type

For more information, see the Derived Events topic in the Events documentation.

Create and configure an asynchronous translation service

An asynchronous service must be created. Note the name of the asynchronous translation service in this example,
'File Exchange Service, ' and the translation configuration, 'English to French.'
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System Setup {File Exchange Service rev.0.1 - Asynchronous Service Configurati... -k
-5 Attribute Groups ] Asynchronous Service Configuration Type |REHIESERTE
Attribute Transformations ' Description
G- E Action Sets MName »| » |Value *
[+]{gha] Contexts
__ InDesign Queu > ID File Exchange Service
.. Lists of Values /LOVs > Mame | File Exchange Service |
' Asset Analyzer » Object Type Asynchronous Service Configuration Type
:Ssezmwt C;”ﬁg_'“rah"”s > Revision 0.1 Last edited by USERK on Tue Apr 30 13:28:28 EDT 2019
-1-(Z5] Asynchronous Services
L= Across > Path Asynchronous Services/File Exchange Service
L2 9 Hotfolder etas
+1-(f5] Completeness Metrics » Bervice File Exchange Service
[#-(5] Data Proflie Configuration
- >
[#-[5) DataSufficiencyScoreGroup LTI [T
[#-[5] Event Processors > In folder n
[#-[75] GDSMReceiverRestBusinessActions > Dut folder out
[]--- Global Business Rules > | Edit Configuration
----- 2] Inbound Integration Endpoints o
y Load Handling
----- Match Codes and Matching Algorithms @ : —
4% Outbound Integration Endpoints » Server Poling Interval in Minutes 1
5] PDS Inbound Setup Group > Maximum Mumber of Processed Jobs to Retain 100
B[] PDS Qutbound Setup Group * Maximum Age of Processed Jobs {in Days) 30
""" -
----- SufficiencyDataContainer
(5] Web s | * |Edit Configuraticn
----- Workflow Profiles  Translation Configuration
""" Workflows Translation configuration L
-[Z| Derived Events  Ergiish to French =
-z Object Types & Structures - = A
[l = V| [P Add
4 >

For more information on asynchronous translation services, including the File Exchange Service, see the
Configuring an Asynchronous Translation Service topicin the Data Integration documentation.

Create and configure an event processor

An event processor (in this example named 'AsyncTrans') with the Asynchronous Translation Message Processor
processing plugin selected must be created in order run the bulk update.

Note: The event processor can be configured to batch events via the 'Number of events to batch' parameter. This
can be useful for batching multiple objects into one translation file, thus reducing translation costs. For more
information, see the Event-Based OIEP Event Batching topic in the Outbound Integration Endpoints
documentation.

© Stibo Systems - Confidential - Release 9.2-MP3 (October 25, 2019) 77



StiboSystems

MASTER DATA MANAGEMENT
System Setup AsyncTrans - Event Processor
|f| Attribute Groups 0 Event Triggering Definitions || Background Processes || Statistics || Error Log Excerpts
() Attribute Transfo AsyncTrans 2
B gctl:;z St:ts *» MName AsyncTrans
ontex
;a InDesign Queve * Type Event Processor
Lists of Values /L » Last edited by 2019-06-25 16:44:45 by USERK
. g Asset Analyzer * Enabled fes
----- Azszet Import Con
>
o @ pomcorms s || P s Ramng
i - ACTOSS D Configuration
: '==’ File Exchange D MName
: g Eo;plpeteﬁnesg M: Lser running event processar plugin DBA
ata Proflie Con
If'ii DataSufficiencyst Mumber of events to batch 1000
[=1-[Z5] Event Processors Days to retain events ]
: % m Queue for event processor EVPROC
----- Data Sufficier
lﬂ. LovTrans Maximum number of old processes 100
#-[£5] GDSMReceiverfe: Maximum age of old processes in hours 168
B @ Global Business R Limit of lines in execution report 1000
----- Default Audit
. % Azh Lt Aud Processor Il.ﬁ.synmronnus Translation Message Processor |
ons
:l (%3] Conditions Schedule Mot scheduled
i [5] Libraries Queue Status Read Events
EEIE?: 0ﬁ1§r1 rearat Unread events (approximated) | Click to estimate ...
----- nbound Integra
> Tean -
_____ (5] Match Codes and v | | Edit Configuration
L @ Current Background Process Log v

Note thatin Step 3 (Configure Processing Plugin) of the Event Processor Wizard, the Event Type (in this case, a
derived event) and the Asynchronous Service were both created earlier in this topic. The Translation
Configuration, 'English to French,' is the translation configuration for the asynchronous service 'File Exchange
Service.' If desired, schedule the event processor to run in Step 4 of the Event Processor Wizard; in this example,
the event processor is scheduled to run every 60 minutes.

E] Event Processor Wizard x
Steps Configure Processing Plugin
1. Identify Event Processor
2. Configure Event Processor Translation Event Configuration Event Type > lasynchronous Se... * [Translation Configuration
3. Configure Processing Plugin > JAsycriTrans_English_to_ French File Exchange Service English to French
4, Schedule Event Processor > | Add
5. Configure Error Reparter Processing Plugin
Translation Completed Business Acﬁonl
Translation Failure Business Action |
£ >

Finish Cancel
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E] Event Processor Wizard x
Steps Schedule Event Processor
1. Identify Event Processor Start
2. Configure Event Processor
3. Configure Processing Plugin (O Never &0 minutes
4. Schedule Event Processor (®) Every
5, Configure Error Reporter Processing Plugin () Weekly
i) Monthly
i) Later
Start every 60 minutes
Back Mext Finish Cancel

For more information, see the Asynchronous Translation Message Processor Processing Plugin
Parameters and Triggers topic in the Event Processors documentation.

Note: The Asynchronous Translation Message Processor processing plugin is only available to users that have
the external-async-kernel component installed in their system. For more information, please contact your Stibo
Systems representative.

Create and configure a business action

A business action that sends a derived event must be created and configured. The image below demonstrates an
example of a properly configured business action capable of generating a derived event per object in the
collection. This business action will be referenced later in this topic when running a bulk update is addressed.
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F5] view Operation >
[ Exeoute JavaSoipt =
Binds: ¢
Variable name * [Binds to * [Parameter >
eventQueus Event Queue cTrans (AsyncTrans,
event Derived Event Type yenTrans_English_to_ French (AsyeonT.
node Current Object
Messages: \ 4
Variable name * |Message * [Translations >
Javascript: 1 eventQueue.queuelerivedEvent(event, node) 6
W
Edit externally
< >

Note that in the example above, the event processor 'AsyncTrans' has been selected in the first row's Parameter
cell, and the derived event'AsyncTrans_English_to_French' has been selected in the second row's Parameter
cell.

For more information, see the Business Actions topic in the Business Rules documentation.

Create a collection

In the example below, a collection consisting of 220 objects that require translation from English to French has
been created.

Eng_French - Collection

#-[7) Assets WD | Data Profile || Log
& 5 Csiaton Posapwn

"1__=I Configurations Marne [ » |value

{2y Index Words > o p—

- Target Markets

- Publications * Mame Eng_French

(+-{£3) Primary Product Hierarchy > Estimated Amount of Objects 220

E‘? C@?"TEJ:;S * Search URL tep: ffsearch?args0.0=nod
' g Temporary Collections > Last edited By 2019-06-25 15:17:07 by US

© E—
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For more information on creating collections, see the Creating Collections topic in the Collections and
Collection Groups documentation.

For more information on searching for translation status, see the Searching for Translation Status topicin the
Translations documentation.

Running the bulk update
To generate a derived event per object in the collection a bulk update action must be executed:

1. Right-click the desired collection and select 'Run Bulk Update.' In this example, the collection 'Eng_French' has
been selected.

Tree
- Assets Data Profile

--1‘_‘=| Classifications

--1‘_‘=| Configurations Marne s |3 |Value
i {2y Index Words - B s
-A_ Target Markets
@ Publications * Mame Eng_French
--1'_=| Primary Product Hierarchy > Estimated Amount of Obje...| (220
EH? %ﬂlligh:;s » Search URL step: ffsearch?args0.0=nodetype%3dprog
-
_@ Temporary Collections » Last edited By 2019-06-25 15:17:07 by USERK
E}@ to translate = Statictice
G- {F] Eng_Frend; =
- il eCatalogs %] Run Bulk Update
-3 Recydle Bin i Export Data Below
Republish...
Refrech

Edit Search Criteria...
¥ Delete

Search Below

The Bulk Update Configuration wizard opens.

2. Inthe Bulk Update Configuration window, select 'Create New Configuration' and click 'Next.'
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F5] Bulk Update 3

Steps Configuration

1. Configuration
2. Operations

3. Parameters

4. Preview

5. Advanced

() Use Existing Configuratior:

(@) Create New Configuration

Back Mext Finish Cancel

3. From the dropdown menu, select 'Run Business Rule' and for the Business Rule Action, select the business
action created earlier, 'AsyncTransBA.'

F¥1 Bulk Update 3
Steps Operations

1. Configuration T

LTS ’VBusiness Fule Condition

3. Parameters Business Rule Action | AsyncTransBA {AsyncTransBA)

4. Preview

5. Advanced

Add Operation
Back Mext Finish Cancel

4. Click 'Finish' to run the bulk update or 'Next' to preview the items within the collection and / or configure the
Advanced screen.

Once 'Finish' is clicked, the background process status window opens, which indicates the status of the bulk
update.

© Stibo Systems - Confidential - Release 9.2-MP3 (October 25, 2019) 82



StiboSystems

MASTER DATA MANAGEMENT

E} Background process status - (100%) >

A badkground process with ID: "BGP_305746" has been started

Description Bulk Update
Status succeeded - (Ferrors: 0, #Fwarnings: 0)
Go to process Close

5. Click'Go to process' for further information about the background process or 'Close.’

For more information, see the Bulk Updates documentation.

Now that the bulk update has been run using the business action described above, the event processor configured
with the Asynchronous Translation Message Processor processing plugin, when run, will send the objects

included in the bulk update to the translation service specified during the configuration of the asynchronous
service.

Note: When the event processor is run depends on the schedule configured in the Event Processor Wizard. For

more information on scheduling an event processor, see the EPW - Schedule Event Processor topicin the
Event Processors documentation.
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